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If you read nothing else..

This guide is designed to get you using your Treo quickly, starting with just the basics. As you become
more comfortable with your Treo and want to learn more, come back and read the other sections.

Read this Now: Getting Started

Follow the instructions on pages 7-16 to set up
your Treo and make your first call.

First Day: Learning the Basics

Read through pages 17-32 to learn how to
enter text, move around the screen and set up
synchronization.

First Week: Using Phone,

Web and Messaging

Learn how to use all the great wireless features
of your Treo on pages 33-80, including phone,
email, web browsing, and messaging.

First Two Weeks: Using Organizer Features

Your Treo is not just a phone. It also includes a
full-featured Palm Powered organizer that gives
you instant access to your Calendar, To Do List,
Memo Pad, CityTime, Calculator, and more. See
pages 81-98.

6 : If you read nothing else..

First Month: Managing Applications

Explore pages 99-108 to learn how to add or
delete extra applications and use an expansion
card with your Treo.

When You're Ready: Customizing your Treo

Once you've learned the basics, you'll want to
explore additional features on your Treo and
customize its settings. See pages 109-126 for
information about these features.

If Something Happens: Help

If something goes wrong or you can't figure out
how to use a Treo feature, we can help. See
pages 127-147 for the answers to frequently
asked questions.

read this now:
getting
started

read this now: getting started
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;1 What you'll need

What you'll need

As you work through the instructions in this guide, you'll need all the items
that came in the Treo box (see page 9) as well as the following:

» a SIM card for which you have an activated mobile account with data
services*
a location with wireless coverage for your phone
an electrical outlet
the computer with which you will synchronize your personal data
the CD included in the box

* We recommend choosing the GPRS data service option. You cannot use email, web
browsing, or picture messaging without data services of some type.

Treo overview

You should have received all of the following components in the Treo box:

Hardware

* Treo handset

* AC charger

» USB HotSync® cable

* headset

« electrical socket adapter(s) (if required in region)

Documentation and software

+ Using Your Treo (this book)
» Synchronization software CD

Treo handset features

The following illustrations show the locations and names of the physical
features of the Treo. Refer back to these illustrations while following the
instructions in this guide.

T i
it

T
D

Antenna

Wireless Mode button
Infrared (IR) port
Ringer switch

Stylus

Expansion card slot

. SIM slot

OMmMoOOm>

g

You can purchase a separate
serial HotSync cable and
other accessories. For more
information, visit
www.handspring.com.

Treo overview
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Be careful not to scratch
or crush your Treo's
touchscreen. Do not store
it in a place where other
items might damage it.

10 : Treo overview
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Phone receiver

LED (Wireless Mode and charge indicator)
Volume buttons

Phone

Calendar

Headset jack

. HotSync and power supply connector

Microphone

Messaging

Screen on/off button
5-way navigation control

. SIM slot
. Camera lens
. Speaker
. Reset button

Reset tool (within stylus)

g

IMPORTANT: Trea's speaker
includes a large magnet, so
be sure not to store your
Treo near credit cards or
other items that could be
demagnetized.

Treo overview = 11




Charging the battery Inserting the SIM card

Before using your Treo, you need to charge the battery. It may not turn on at Your Subscriber Identity Module (SIM) card contains account information such

all when you first remove it from the box. We recommend three hours for a as your phone number and voicemail access number. To use the phone, email, @
full charge, or until the LED is solid green. or web features of your Treo, you need to insert the SIM card. If a SIM card Your mobile service
usage, Cansumpton factors 1. Plug the AC charger into a wall outlet. If necessary, connect an adapter. did not come with your Treo, your mobile service provider will give you one provider may already have
include signal strength, 2. Connect the charger cable to the bottom of the Treo with the word UP when you subscribe. If you have an older, 5-volt SIM card, you should request '”SEHTEd thf Sth card into
backlight and speakerphone facing the same way as your Treo screen. a newer, 3-volt SIM. This Treo is not compatible with older 5-volt SIM cards. inupr t[:e[]ﬂégg ;ft 0ase,
usage, and whether calls ‘

are data or voice calls. A . A. SIM tray To remove the SIM card,
A E B. SIM card pull the SIM tray out of the
C. Notches slot and remove the card

D. SIM slot from the tray.
B D

—C

Battery consumption varies
based on your personal

x

3. To confirm your Treo is charging, check the LED.
* When the LED is solid red, your Treo is charging. . Slide the SIM tray out of the Treo.
* When the LED turns solid green, your Treo is fully charged. . Insert the SIM card into the SIM tray by aligning the notches until you
+ If the LED does not turn on when you connect your Treo to the feel it lock into place.
charger, double-check the cable connection and the electrical outlet . Slide the SIM tray back into the Treo.
to which it is connected. . If your SIM card is not already activated, follow the activation steps
provided by your mobile service provider or contact them directly for
After you turn on your Treo, the onscreen battery gauge displays power status: assistance. If you want to use email, web browsing, and MMS, be sure to
Full battery icon fl : Battery is charged confirm that your SIM card is activated for data services.
Partial battery icon i : Battery has some power and is not charging
Empty battery icon [ : Battery needs charging immediately
Red lightning bolt i : Charging
Green lightning bolt with full battery 4] : Fully charged

12 Charging the battery Inserting the SIM card 1 13
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Treo includes a keyboard
backlight for nighttime use.
The keyboard backlight
activates automatically when
the screen tums on, but
shuts off if the keyboard is
not in use. When the screen
is on, press Option then the
P key to manually activate
the keyboard backlight.

Turning Treo on and off

You can use the Palm OS features of your Treo independently of the

wireless features and applications. Therefore, the screen and Wireless Mode

are designed to be turned off and on separately.

Turning the screen on and off

1. Press the Screen button &) to turn on the screen.
2. Briefly press the Screen button @) to turn off the screen.

Turning Wireless Mode on and off

Wireless Mode allows your Treo to connect to a mobile network so that you

can make and receive phone calls and use other wireless services.

1. Press and hold the Wireless Mode button (!) to turn on Wireless Mode.
You will hear a series of ascending tones. When Wireless Mode is on,
your Treo connects to a mobile network, and you can use the phone and
Internet features (if supported by the local network).

. Press and hold the Wireless Mode button () again to turn off Wireless
Mode. You will hear a series of descending tones. When Wireless Mode
is off, your Treo does not have a connection to any mobile network. You
can still use the organizer and other Palm OS features. This is ideal for
airplane flights and for maximizing battery life.

14 ' Turning Treo on and off

Making your first call

We recommend that you charge your Treo for a full three hours (or until the
LED is solid green) before using it for the first time.

1.

Press and hold the Wireless Mode button (%) . You will hear a series of

ascending tones.

. If a Welcome screen appears, follow the onscreen instructions to set up
your Treo.

. Allow the Treo to complete a network search. The search may take several
seconds. When it is complete, the network status icon T appears in the
upper right.

. If prompted for a PIN, enter it on the PIN screen. The default PIN is often
1234. Otherwise, your mobile service provider may have given you some
documentation with this information. Contact your mobile service provider
for help.

. Press Phone ®.

. Using the number pad on the Treo keyboard, type the desired phone

number.

. Press Center to dial.

. When your call is complete, use the 5-way navigation control to choose
Hang Up.

O]
Dial Clear Cancel

%

g

If No Service appears in the
upper left, you are out of a
wireless coverage area. If
you believe you are in a
wireless coverage area and
this problem persists, contact
your mobile service provider
for assistance.

If the Welcome screen does
not appear, recalibrate the
touchscreen. This ensures
that the screen responds
accurately to taps (see
page 133).

Learn how to quickly redial
your most recent calls on
page 38.

Making your first call :: 15




Adjusting call volume

&

While a call is in progress, press the volume buttons on the side of your Treo
to adjust call volume.

16

A. Volume buttons

What's my number?

1. Make sure Wireless Mode is on (see page 14).

2. Press Phone ®).

3. Press Menu (meny) .

4. From the Options menu, choose Phone Info (/1). If your phone number is
not displayed, exit Phone Info, and make sure your SIM card is properly
inserted in the SIM slot. If your phone number still does not appear in
Phone Info, consult your mobile service provider.

[ Phoneinfo ]
Number: §50-555-4567 A
IMEI Number: 0055577700577
Handspring SN: HERDAZ2ZSEA026
SA Number: 1005500550

Firmware: 1.0
Software: Treo 600 - XK - 1.0
Hardware: i

oK |

A. Look here for your phone number

1 Making your first call

first day:
learning

the basics

first day: learning the basics

17
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Some third-party applications
may not work with 5-way
navigation, and you must use
the stylus instead.

In this guide, we use arrow
icons to indicate directions
on your Treo's 5-way
navigation control. These are
different from any onscreen
arrows that you tap with
your stylus or select with
the 5-way control to display
pick lists.

5-way buttons:

On screen arrows:

1704 H A[s[m[T]Rl7| 3

Moving around the Treo screen

To move around the Treo screen, you can use the 5-way navigation control,
or tap items on the screen with the stylus. With use, you will find your own
favorite way to scroll, highlight, and select menu commands.

The 5-way navigation control includes Right, Left, Up, Down, and
Center buttons.

A
l A. Up
B. Down
C—+« »r— D C. Left
D. Right
'l E. Center

eSS

Scrolling through screens

As on a computer, you scroll on the Treo to move from field to field, or page

to page, or in some cases to highlight an item or option in a list. There are

several methods of scrolling:

» Press the b-way navigation control on the front of the Treo. Pressing
Right >, Left <, Up , and Down moves to the next field, button,
or action in that direction.

18 1 Moving around the Treo screen

» Tap an onscreen scroll arrow:

EMTIRAFE] P +4

Ith Llaire

50-CEE-1704H

+ Press Option () and Up 4 or Down  to scroll to the next page of
information within the current record.

* When inside a text field, press Up
the text.

* Drag the slider of an onscreen scroll bar.

and Down w to scroll through

Highlighting items

The b-way navigation control lets you highlight items before launching or

selecting them.

+ When an onscreen button (OK, Cancel, etc.) or pick list is highlighted, the
button acquires a blue glow around its border.

Lok
* When a phone number, email address or web link is highlighted on a web
page or in a message, the text appears in reverse type (light text on a
dark background).
* When an entire text entry field is highlighted, you can press Center to
edit the text. After you edit the text, press Center again to highlight the
entire field.

Meed a new caze or headset? Go to
i handspring.corng R GEN IR
gocessories, Or, call §50-EEE-2300,

g

Once you've launched an
application (see page 20),
you can experiment with
using the navigation control
to highlight different screen
elements.

Moving around the Treo screen :: 19
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You can also use the stylus to highlight text on the screen. When text is
highlighted it appears in reverse type.

* Drag the stylus across the text you want to highlight.

» Double-tap a word to highlight it.

» Triple-tap a line of text to highlight it.

Accessing command buttons

Command buttons, such as New, OK, and Details appear at the bottom of
the screen. In many cases you can jump directly to these buttons instead of
scrolling to them.
+ From alist screen, such as the Contacts list or Mail inbox, press Right to
jump to the first button.
From a screen where you create or edit entries, such as Edit Contacts or
Day View in Calendar, press Center to jump to the first button.
From a dialog box, such as the Edit Categories, press Right to scroll to
the first button, or press Option () then Return (@) for OK, or Option ()
then Backspace (=) for Cancel.

Choosing or activating items

After highlighting an item with the 5-way navigation control, you can choose
or activate it by pressing Center. You can also choose an item by tapping it
with the stylus.

Selecting menu items

Many applications have menus to provide access to additional features.
These menus are usually hidden from view, but they appear when you
press Menu . To get the most out of your Treo, it's a good idea to
familiarize yourself with the additional features available through the
various application menus.

Moving around the Treo screen

. Press Menu to display an application’s menus.

. Press Right »» and Left < to switch between menus.

. Press Up and Down " to highlight a menu item.

. Press Center to choose the menu item, or press Menu to close the
menu and cancel your selection.

Record Edit el 24l Views
A Display Preference 0
Sound Preferences.. W

C CallPreferences... il
Dial Preferences... E
Call Barring...

Select Network..

G Phone Tips
About Phone
FavOre:

Applications 4 5 b Carera
Contacts

Choosing options in a pick list

A range of options is often presented in a type of menu called a pick list,

which can be identified by a downward-pointing arrow. Pick lists are

different from the application menus described above.

» Use the b-way navigation control to highlight the pick list, then press
Center to display the items in the list. Press Up 4. and Down + to
highlight the item you want, then press Center to accept your selection.
To exit the pick list and cancel your selection, press Left < or Right

Use your stylus to tap the pick list, then tap the item you want from the list.

Change Security 6 Change Security 6

Current Current
Privacy:  Show Recerds Privacy: [ =]

(G e

g

Most menu commands
have keyboard shortcuts
listed in the menu. To use a
shorteut, press Menu plus
the shortcut letter. You
don't have to see the menu
item to use the shortcut.

Moving around the Treo screen :: 21




When using the keyboard,
most people find it easiest
to hold the Treo with two

hands and use the tips of
both thumbs to press the

keys, as shown above.

22 1 Using the keyboard

Using the keyboard

Option

Shift/Find

Alt

Space

Applications Launcher
Menu

. Return

Backspace

A
B.
C.
D.
E.
F.

G
H.

Using the keyboard backlight

+ To turn on the backlight, press Option (0) then (& . The backlight may not
be visible in bright sunlight.
» The backlight will turn off if the keyboard is not in use.

Entering lowercase and uppercase letters

To type lowercase letters, press the desired keys.

To type an uppercase letter, press Shift (#8), then type a letter. You
don't need to hold down Shift while typing a letter.

To turn Caps Lock on, press Shift twice. To turn it off, press Shift
again. When Caps Lock is on, this symbol appears in the lower
right: #

Entering numbers, punctuation, and symbols that appear
above the letters on the keys

Press Option (), then press the key with the desired character shown
above the letter. You don't need to hold down Option while pressing the
second key.

To turn Option Lock on, press Option () twice. To turn it off, press
Option () again. When Option Lock is on, this symbol appears in the
lower right: @

Entering other symbols and accented characters

1

. Type the character that corresponds to the symbol or accented character

you want. See the table on the next page.

. Press Alt @0).
. Press Up
. Press Center to insert the character, or just continue typing the next

or Down " to highlight the desired character.

character.

In many applications you
can view a list of all the
alternate characters. From
the Edit menu, choose
Keyboard Help (/G).

Some application views
automatically default to
Option Lock, such as the
Dial Pad of the Phone
application, or the
Calculator. In this case, you
do not have to hold down
Option to enter numbers.

The alternate characters
are grouped according to
their similarity to the
corresponding key. For
example, the alternate
characters available for the
gkeyare &8 8 éande.

Using the keyboard :: 23




Launching applications )

Symbols and accented characters

Type... then press Alt Type... then press Alt Type... then press Alt
to choose... to choose... to choose... Each of the three application buttons on the front of the Treo can be used to @

launch two applications. To access a button’s primary application, simply press
43434484343 60006 e0do % %o ° the button. To access a button’s secondary application, press Option O , then You can also customize the

P, s N i press the application button. The fourth button turns the screen on and off, buttons yourself; see page
AAAAAAAE O0O0OO0OEOO /4 /o and controls the keyguard. 11T for details.

B % 1 2 Your mobile service provider

A~ 33 may have customized the
c¢o ® 74 applications associated with

Ceo n" Bs§Q . 21 each button.
t# BS &3
teD R T

éeeeé € aguda
“EEE € uouou
x O

J

V¥
Y ¥

A. Phone

B. Calendar
C. Messaging
D. Screen

24 1 Symbols and accented characters Launching applications :: 25
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Press Applications Launcher
repeatedly to cycle through
different categories of
applications.

In the Applications Launcher,
you can type the first few
letters of the application’s
name to highlight it. For
example, if you type ¢ it
highlights Calendar, then if
you type i it highlights
CityTime. If you pause and
then type 1, it highlights the
first application that starts
with i.

Button  Primary application
Phone O +® Blazer* Web Browser

O+ Calculator

SMS O +@ Mai

O+ Keyguard

Secondary application

Calendar

Screen (on/off)

In Palm OS, you access all available applications through a screen called the
Applications Launcher:

1. Press Applications Launcher @.

2. Use the b-way navigation control to highlight the application you want to use.
3. Press Center to launch the selected application.

«#

Merno Pad SN Frefs

&

Security S Book Sl Srvcs

] Tololist  Tutorial

Welcorne

26 : Launching applications

Setting up your computer

Synchronization lets you enter information on your computer (using Palm
Desktop or Microsoft Outlook for Windows) and then efficiently transfer that
information to your Treo. At the same time, changes you make on the Treo are
transferred to Palm Desktop or Microsoft Outlook. Even if you manage all your
contacts on your Treo, synchronization is a great way to back up your data.

Before you can synchronize, you need to install the Palm Desktop
synchronization software on your computer. Even if you already own a Palm
Powered device and have installed a previous version, you must install the
software that comes on the CD with your Treo.

Windows 98SE, Me, 2000, or XP*

+ 32 MB of memory

* 30 MB of free hard disk space

+ CD-ROM drive

+ available USB port

+ USB HotSync cable (included with your Treo)

Windows NT 4

* 32 MB of memory

» 30 MB of free hard disk space

+ CD-ROM drive

* available serial port

+ serial HotSync cable (sold separately)

Macintosh OS 10.1-10.2.x*

+ 32 MB of memory

* 25 MB of free hard disk space

+ CD-ROM drive

» USB port

+ USB HotSync cable (included with your Treo)

*later versions may also be supported

IMPORTANT: If you're
upgrading from another
Paim Powered device, follow
the upgrade steps on page
128 before you set up your
computer for your new Treg.

If you are synchronizing
with a computer that is
running Windows NT 4,
you must use a serial

HotSync cable, available
for separate purchase at
www.handspring.com.

Setting up your computer 1 27




For best performance, plug
your USB synchronization
cable directly into a USB
port on your computer. If you
use a USB hub, make sure it
is a powered hub.

Connecting your Treo to your computer

1. Plug the AC charger into a wall outlet. If necessary connect an adapter.

2. Connect the charger to the short end of the HotSync cable. Be sure to
match the sides of the connectors labeled UP.

3. Plug the USB HotSync cable into an available USB port on your
computer.

4. Connect the long end of the HotSync cable to the bottom of your Treo
with the button facing up.

A. USB cable
B. HotSync button

28 : Setting up your computer

Installing the Palm Desktop synchronization software on
your computer

Your computer needs to have all its resources available to install the

software. Follow these guidelines for a successful installation:

1. Exit any applications that are currently running on your computer,
including those running in the background.

. Insert the CD that came with your Treo into the CD-ROM drive on your
computer. If you are installing on a Macintosh, double-click the CD icon
on the desktop, then double-click the Installer icon.

. Follow the onscreen instructions of the installation program. Click Install
Now to install the Palm Desktop software. Please note these important
points about the installation process:

» If alanguage selection screen appears, click the same language you
use on your Treo.
During the installation process, you will be prompted to synchronize
for the first time.

If you are installing on a
computer at work, make
sure your company allows
you to install new software.
Contact your company's IT
department for help.

Setting up your computer :: 29
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We strongly recommend that
you install the Paim Desktop
synchronization software
soon after you start using
your Treo, and that you
synchronize your Treo and
computer frequently to keep
your information up-to-date
(and backed up) in both
locations.

Synchronizing contacts and
other personal data

Before you can synchronize your contacts and other personal data, you
must install the Palm Desktop software from the CD that came with your
Treo. See page 29 for instructions.

1. Connect your Treo to your computer as described on page 26.

2. Press the HotSync button on the cable.

A. HotSync button

3. Wait for your Treo to display a message indicating that the process is
complete.

* If nothing happens, make sure that you installed the Palm Desktop
software and that the HotSync Manager application is running on
your computer ( (#)).

If you want to synchronize data with applications other than Palm
Desktop or Microsoft Outlook, you need to purchase additional third-
party conduit software.

* If you have any problems performing a HotSync operation, see pages
137-139 for troubleshooting suggestions.

30 : Synchronizing contacts and other personal data

Battery life

Battery life depends on individual usage. When used as a phone, your
Treo battery provides approximately 5 hours of talk time or 10 days of
standby time. When used as an organizer only (no phone), the battery
provides about 10 days of normal use.

Maximizing battery life

You can increase the life of your Treo battery by following a few easy

guidelines. Remember that battery life depends on how you use your Treo.

» Charge your Treo whenever you're at your desk. The Li-lon battery in your
Treo has a much longer useful life when it is topped off frequently, versus
charging it after it is fully drained.

The wireless features (phone, email, messaging, and web) of your Treo
generally consume more power than its organizer features. However, if
you spend a lot of time using the camera, games, media players, eBooks,
or other Palm OS applications, keep an eye on the battery level and
charge when necessary.

If you don't plan to use the wireless features on your Treo for a while, you
may want to turn off Wireless Mode (see page 14). You can forward calls to
a different number or let all calls be picked up by voicemail (see page 45).
As with any mobile phone, if you are in an area with no wireless
coverage, your Treo searches for a signal, which consumes power. If you
cannot move to an area of better coverage, you may wish to temporarily
turn off Wireless Mode.

Use the keyboard backlight (see page 22) only when you need it.

Turn down the screen brightness (see page 114).

Decrease the Auto-off setting in General Preferences (see page 120).
This turns off your screen automatically after a shorter period of inactivity.

IMPORTANT: You must
charge your Treo fully
before using it the first
time. Wait until the LED
turns solid green which may
take up to three hours.

If the battery drains to the
point where your Treo
doesn’t tur on, the Treo
stores your data safely for
about three days. We
recommend that you charge
and synchronize your Treo
every day, especially if you
use your phone often.

If the battery is fully
drained, it may take a few
moments for the LED to
turn on while charging.

Battery life 1 31




d%~ | Where to learn more

@ A quick introduction to your new Treo

" » Tutorial: The Tutorial teaches you how to use many features of your Treo.
To launch the built-in

worial: It is already installed on your Treo and you can launch it any time. fl rS-t We e k :

. Press Applications While using your Treo
Launcher.

[ |
Chaose the nick st » Tips: Many of the built-in applications include helpful tips for getting the
. theoa;zer_engh‘i s‘esle[,!tﬂ Al most out of your Treo. To view these tips, launch an application, press l I S I I I O I l e
' ' Menu , then from the Options menu, choose Tips. ’

o

oo

. Choose the Tutorial icon.
.~ Follow the onscreen * Information: Many screens have an Information icon E] in the upper-

o~

instructions in the right corner. Tap the Information icon with your stylus to learn about the

Tutorial tasks you can perform in that dialog.
*  Online support from Handspring: For up-to-date downloads, troubleshooting ,

and support information, check out www.handspring.com/support.

If you need more information

1
* Books: Many books on Palm Powered devices are available in local or I I I I I I
online book retailers (look in the computers section).

* Online forums: Consult online Treo user discussion groups to swap
information and learn about areas you may find nowhere else.

» Customer service from your mobile service provider: For questions
about your mobile account or features available on the network, contact
your mobile service provider for the latest information and help.
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Phone overview

Phone overview

The Phone application lets you make and receive calls, store information
about your contacts, and store Favorites for contacting people and
launching applications. Be sure you know how to turn on Wireless Mode
before reading this section (see page 14).

Accessing the Phone application
+ Press Phone ®).

Service Th ﬂ

1078703

Favaritas
Applications 4 5 b Comera
Contacts

You can monitor the status of several items, using icons at the top of the

Phone screen:

Network name

Displays the name of a mobile service provider when
Wireless Mode is on and you are in a coverage area. If you
are outside a coverage area, No service or SOS Only
appears instead.

%

Appears when call forwarding is active.

Appears when you have voicemail. Some networks use a
full-screen alert instead. Call your mobile service provider
for more information.

Appears when ALS, Alternate Line Service, is active.
This feature may not be available on all accounts or
regional networks. Contact your mobile service provider
for more information.

Appears when Wireless Mode is on and a GPRS network
is within range.

Appears when Wireless Mode is on but you are not
connected to any GPRS network.

Appears when you are connected to a GPRS network and
a data session is active (for example, when you are
browsing the web). You can still receive calls.

Displays the signal strength. The stronger the signal, the
more bars appear. If you are outside a coverage area, no
bars appear.

Displays the battery charge status. As the battery drains,
the icon changes from blue to clear, and then to red when
it's time to recharge.

Appears when your Treo battery is charging.

Appears when your Treo battery is fully charged.

g

To display details about
your battery power, tap the
battery icons at the top of
the screen.

If ALS is active and

available, you can press
and hold # to switch lines.
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To see more information for
a person in your Contacts
list, highlight the name and
press Genter to view their
address, company and
other details.

You can begin a Name
Lookup immediately from
the Main view in the Phone
application. From the
Options menu, select
Display Preferences, and
choose Typing Starts
Contacts Search.
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Dialing calls

Your Treo offers several options for making phone calls. As you get familiar
with your Treo, you'll discover which method you prefer.

Dialing with the keyboard

1. Press Phone ®).

2. Using the numbered keys on the keyboard, start typing a phone number.
You do not need to press Option to access the numbers on the keyboard.

3. Press Center to dial.

Dialing by contact name

Before you can dial a call by contact name, you must create some contacts
(see page 47), or import them with a HotSync operation (see page 30) or
from your SIM card (see tip on page 48). The first time you display the
Contacts list, Treo asks if you would like to import any numbers from your
SIM card into your Contacts list.
1. Press Phone ®).
2. Use the b-way navigation control to access the Contacts list.
3. Using the keyboard, begin typing one of the following for the contact you
want to call:
 Firstinitial and last name
« First name
* Last name
. Choose the number you want to dial.
. Press Center to dial.

To start another search, press Backspace (<) to delete letters you've
entered. Or, just press Phone to start all over.

Dialing with a Favorites button

Before you can use Favorites buttons, you must create some Favorites

entries. See page 49.
1. Press Phone ®.

2. Use the b-way navigation control to access your Favorites buttons.
3. Highlight the desired button.
4. Press Center to dial the selected button.

Dialing using the onscreen Dial Pad

1. Press Phone ®).

2. Tap the onscreen Dial Pad to enter the number.

3. Press Center to dial.

> Al ol

+496915206305 W
+49619654398 H
Durant, Pierre
+336548BT6T6 W
+33672356451M
ordon, Fva

+447654250M
+A4ITE156FT66AW

artin, Sally
4085554213 H

Service Tl g

+336542276 76|

Mew Contact ¢

Voicernail 1 || G Applications

Martina
Pietre
o=
@ )

IIZ345

-0 . jem
Dial Clear Cancel

%
¢

You can paste numbers
directly into the Dial Pad
view. Copy a number from
another application, then
switch to Dial Pad view.
Press Menu, then from the
Edit menu, choose Paste.
Press Center to dial.
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If you can't highlight and
dial a phone number on a
web page or in a text
message, using the 5-way
navigation control or stylus,
it means that Treo does not
recognize it as a phone
number.
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'I\"Iessuge 1of 17 Tall
From: +16505E53555
Drate: 1011703 4:03 pr

Hex! Check out

bt tp:“wwwhandspring.com and
then give me a call ot + 1650555 1254 £G Plumbing

if wou want roreinfo.... (415} 555-1213

5427 Cherry Orchard 5t
San Franciscoe, CA Map

S0 Plumnber

{415} 555-1212
2200 Apple Garden 5t
San Francisco, CA Map

S tupendous Plumbing

| Done | Respond » DE e e Ta

Dialing from a web page or text message

Treo recognizes most phone numbers that appear in web pages or text

messages.

1. Use the 5-way navigation control to highlight the phone number you
want to dial in the web page or text message.

2. Press Center to dial.

Redialing the last number you called

Do either of the following to redial the last number you called:

+ Press Phone &), then press Center to display a list of your most
recently dialed numbers.
Press Phone &), then use the 5-way navigation control to launch
Dial Pad. Choose Dial to display the last number you dialed.
Press Phone ®&), then press Menu (mend) . From the Views menu,
choose Call Log (/Y). This view shows all your recent calls in
chronological order.

Bervice i | canl Loo ST TR

John Sith{W}
16505555231
b 16505555231
Smilla Anderson (W) :]] EG‘:':(gn:;nrm(W)

Geoff Elzner {(H) o
East Bay Municipal Uti.. |. gz‘f:;;:;':;':(\?;”

Erik Cline (W1} i :
Bjorn Billhardt (W) 211 r;;:;;?g;;gi(W)
Lucinda Bar tley (W) | Eva (N1}

650-555-5535 P
Dave Cagle (W} | Greg Shirai{W)

Contacts [[Dretail:)

Receiving calls

To receive calls, Wireless Mode must be on. This is different from having
just the screen turned on (see page 14).

To answer a call, do one of the following:

* Using the 5-way navigation control, choose the onscreen Answer button.

*+ If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:
+ Press Backspace (+).
* Using the b-way navigation control, choose the onscreen Ignore button.

To silence the ringer while your phone is ringing:

* Press the volume buttons or any key on your Treo except the b-way
navigation control, Space, Return, or Backspace.

* To immediately silence all system sounds including the ringer, slide the
ringer switch to Sound Mode Off &' .

When you silence the ringer, you can either answer the call or let it ring

through to voicemail.

If audio (MP3 music, for example) is playing, and a call arrives, you can still
hear the phone ringing softly. To answer the call, do one of the following:

* Using the b-way navigation control, choose the onscreen Answer button.

*  Press the headset button (if headset is attached).
The audio continues playing but you won't hear it during your call.

%
¢

To prevent calls from
accidentally being answered
while the phone is in a
pocket or briefcase, you can
disable the touchscreen
when an incoming call
arrives (see page 121).

See a photo of the person
calling you! Learn how to
assign a caller 1D picture on
page 112.
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When you have a new voicemail message, you are notified with an alert.
A voicemail icon C1E3 may also appear near the top of your screen (this
feature is not supported by all mobile networks).

Setting up voicemail

1. Turn on Wireless Mode, as described on page 14. — @
pag If a voicemail icon appears in
2. Press Phone ®). .
OO Youhave new voice the title bar at the top of the
mail screen, you can tap this icon
B —— to retrieve your voicemail.

3. Use the 5-way navigation control to access Favorites.
4. Choose the voicemail Favorites button.

Service Illlﬂ v

Woicernail 1 | € Applications

[ & Mews

Martina

EEIMMS [® Dawnloads 1. Press Phone ®).

L J 2. From the Phone application Main view, Dial Pad, or Favorites, press and
[1 BBOE hold 1 on the keyboard. Treo dials your mobile service provider's

voicemail system.

Your Treo connects to your mobile service provider's automated voicemail . Enter your voicemail password using the Treo keyboard, or choose Extra

system. If your Treo is unable to connect to the automated system, please Digits if you defined this option (see page 51 for information on editing

contact your mobile service provider for assistance. Favorites buttons). Remember, you do not need to press Option to type

numbers, *, or # while on an active call.

Fere | @ sports Retrieving voicemail messages
@ Camera :]
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@ When you make or receive a call, the Active Call view appears. Use the 5-way Treo offers many advanced telephone features, including call waiting, @
navigation control to access the onscreen buttons in this view: conference calling, and call forwarding. You can use nearly any

Press Phane repeatedly to  Hang Up (or pressing Backspace (=)): Ends the call immediately. You can ather application on Treo

foggle between the Active also press the headset button (if the headset is attached). Making a second call while holcing a phone

call screen and the Main ; . Qwi T
Jiew o the Phone Spkr-phone (or pressing Space (___ ): Switches to the personal You can make a second call while your first call is still active. cunversatl?n,tlﬂcludlng the
organizer features an

- speakerphone. 1. After dialing the first numb the 5- igati trol
anolication. . After dialing the first number, use the 5-way navigation control to
w Hold (or pressing Period () ): Places the current call on hold. choose Hold SMS. You Balnnﬂr]tllsend and
: receive email while on an

The personal speakerphone Dial Pad: Opens the Dial Pad so you can manually dial additional numbers. . Use the navigation control to choose Add Call. active call. To return 10 an

lets you use nt‘her features, Mute: Mutes the Treo microphone so you cannot be heard. . Dial the second number using Favorites, Contacts, Dial Pad, Call Log, or active call fom another
such as checking your Add Call: Lets you place another call while keeping the first call active. Redial list (see pages 36-38). application, press Phone.

calendar, during 2 call. First choose Hold, then choose Add Call.

The Extra Digits buton Extra Digits: Dials any extra digits (such as a password or extension) that
appears only during you assigned to an Favorites button. See page 50 for information on
outbound calls to numbers creating a speed dial Favorites button.

that include pre-defined

extra digits. Service T g

) ) Greg Shirai (W) fctive
To avoid accidentally T 33654227676 oo-03
pressing onscreen buttons B4+—mm—+—

while you're holding the
phone up to your ear to

speak, you can disable the x

touchscreen during active

calls (see page 122). - “T"e
D

u
C

The Active Call view now includes two status lines, each representing one of
the calls. To switch between the two calls, choose Swap.

o0 Thi 4

GregShirai (W) onHold
Caller's name and number +3365422 7676 00:19
Current duration of call Smilla Anderso...
Hang up immediately 6505554438
Switch to speakerphone
Place current call on hold

Mute the microphone 20| om0
Open Dial Pad view Spki
Shone Swap Conf

Fctive

OMMOO®>
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Answering a second call (call waiting)

When you are on an active call, you can receive a second call. When the
second call comes in, the Call Waiting dialog appears, giving you the
following options for handling the second call:
» To place the current call on hold and answer the new call, use the 5-way
navigation control to choose Answer.
To send the new call to voicemail, use the navigation control to choose
Ignore.

Making a conference call
You can join a total of five other calls in a conference session, provided that
your network and service plan include 6-way conferencing. Please contact
your mobile service provider for more information. Minutes in your mobile
account may be deducted for each active call you place.
1. While the first call is active, place or answer a second call.
2. Use the b-way navigation control to choose Conf. This joins the two
active calls in a conference session.
. Repeat this process to add other calls to the conference call.
. To end the conference, use the navigation control to choose Hang Up
and end all the calls.

Service

Group Conference OnHold
01:17

Smilla Anderso... Active
6506654438 00:01

a0
Swap Conf

Forwarding all calls

You can forward all of your calls to another telephone number. You can also
selectively forward certain calls (see page 46). Keep in mind that your
mobile service provider might charge you for forwarded calls.

1. Press Phone &).

2. Press Menu (meny) .

3. From the Options menu, choose Call Preferences (/A).

Call Preferences [i]

Forward all calls:
w Don't forward calls
If Forward all is off, forward:

WWhen busy: w GEOSEEZ3]

Mot answered: w Lon't forward call
OffMa service: w Don't forward call

O Disable Call Waiting
O Block outgoing caller ID

4. Choose the Forward all calls pick list.

* If the forwarding number appears in the pick list, select the number.

* If the forwarding number does not appear in the pick list, select Edit
Numbers, then choose New. Enter a forwarding number, including the
area code or country code if it is different from your mobile phone
number. Choose OK to finish.

5. Choose OK.
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Forwarding calls under certain conditions i %
You can forward calls to another number when the line is busy, a call is Manag ! ng ContaCtS S

unanswered, Wireless Mode is off, or you are outside a coverage area.
1. Press Menu (men) .

9. From the Op&s menu, choose Call Preferences (/A) Contacts is a view in Phone. If you are familiar with Palm Powered devices, @
3. Choose the Forward all calls pick list, then select Don't forward calls. you may recognize this application as similar to the Address Book on
4.

Choose any of the following pick lists: previous devices. ![L);Unuter:?\i/t?sS;v;rfle?f?;?nits
*  When busy: Forwards calls if the phone is busy. to use the Palm Desktop

* Not answered: Forwards calls instead of sending to voicemail. Adding a contact software or Microsoft
+ Off/No service: Forwards calls when your Treo is not connected to a 1. Press Phone ®. Outiook on your computer
mobile network. 2. Use the b-way navigation control to access the Contacts list. and then synchronize deta
) ) . between the Treo and your
If the forwarding number appears in the pick list, select the number. If the 3. Choose New Contact. computer, For mare
forwarding number does not appear in the pick list, select Edit Numbers information, see page 30.
then choose New, enter a forwarding number, and choose OK to finish. contact Edi+ NI 1

B. Choose OK. Last narne| In the Contacts View, UD
Fir st narne:

Title: and Down move to the
Campany:

. : revious or next Contacts
Call Barring - Work: p

- Home: record.

. . . Wobile:
Call Barring lets you prevent unauthorized calls on your Treo. This feature = Other

may not be available on all mobile networks. Contact your mobile service T Be sure to label your

provider for more information. e " contacts” mobile numbers
You must enter your Call Barring password every time you change your [Done ) (Detat. ) hs ;U”I?c[};gﬁnTr:eiMz  6)

Call Barring preferences. Contact your mobile service provider if you do not 4 Use the 5 oat ol bet fiold . w[i)l[ll only ok uppnfmbers

. . Use the 5-way navigation control to move between fields as you enter

know this password. information ynavie y labeled as Mobile

1. Press Menu (meny) . '

2. From the Options menu, choose Call Barring 5. To place the entry in a category or mark it private, choose Details.

3. Choose the onscreen pick lists, then select your Call Barring preferences. 6. To add a note to an entry, choose Note.

4. Choose OK 7. After you enter all the information, choose Done.
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Import contacts from your
SIM quickly and easily.
Press Phone, then use the
5-way navigation control to
open Contacts view. Press
Menu, then from the
Record menu, choose
Import from SIM.

48 1 Managing contacts

Viewing or changing contact information
1. In the Contacts list, begin typing one of the following for the contact you
want to view or edit:
« First initial and last name
* First name
* Last name
2. Choose the name of the entry you want to open.
3. Choose Edit.
4. Make changes to the entry as necessary.
5. Choose Done.

Deleting a contact

1. Open the contact you want to delete.

2. Press Menu .

3. From the Record menu, choose Delete Contact (/D).
4. Choose OK.

Defining your business card

1. Create a new contact with your business card.
2. While still in Contact Edit view, press Menu .
3. From the Record menu, choose Select Business Card.

Now you can beam your business card to other Palm OS devices. In any
Phone view, press Menu . From the Record menu, choose Beam
Business Card (/M).

Defining Favorites buttons

Treo provides 50 programmable Favorites buttons for quick access to the
following common tasks:

+ Dialing a phone number (speed dial)

* Launching an application

» Accessing a web page

» Addressing a text message

+  Accessing voicemail (preset on Treo)

Your mobile service provider may include special Favorites buttons on your
Treo that are customized for their services.

Service T|I|ﬂ
Woicernail 1 | Applications
Iar tina _
Fierra @ Mews

EEIMMS [ @ Sports

@ Downloads

ENz[3]a]s

& Carmnera

When you are in the Main, Favorites, or Dial Pad view, you can press and
hold a Quick Key to launch the Favorite associated with that key. Quick
Keys are optional, must be letters, and are not case sensitive.

Defining Favorites buttons

%
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To see the next page of
Favorites, press Right
repeatedly. To see the
previous page, press Left
repeatedly.
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To see all the contact
numbers for the selected
person or business, highlight
the Favorite button and
press Space.

To add a photo caller-ID
image, a special ring tone,
and extra digits, choose
More.

Creating a speed dial Favorites button

. Press Phone ®).
. Use the b-way navigation control to access your Favorites buttons.

. Choose a blank button.

. Choose the Types pick list, then select Speed Dial.

. Enter a label for the favorite:

+ If the entry is for an existing contact, choose Lookup. Start typing the
last name of the contact, then select the contact when it appears in
the Lookup list.

« If the entry is for a new contact, type the Label, press Down + and
type the Number.

. (Optional) Enter a Quick Key. When you are in the Phone application, you
can press and hold the Quick Key to instantly launch the favorite.
. (Optional) Choose More, and select advanced options:

» Extra Digits: Lets you define additional digits to dial, such as a
password or extension.

Dial Extra Digits Automatically: Dials pre-defined Extra Digits
immediately after dialing the phone number, when checked.
Ringtone: Assigns a special ringtone for incoming calls from that
contact.

* Image: Assigns a Caller ID picture that displays when that person calls.

8. Choose OK.

Type: » Speed Dial
Label: John (¥}
Number: 14155557842
Quick Key: ] {press and hold}
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Creating an application, message or web link Favorites button

. Press Phone ®).
. Use the 5-way navigation control to access your Favorites buttons.
. Choose a blank button.

. Choose the Types pick list, then select Application, Message or Web Link.

. Enter a label for the favorite, and enter any other necessary information
on the screen.

. (Optional) Enter a Quick Key that launches the favorite when pressed
and held.

. Choose OK.

Editing or deleting an existing Favorites button

. Press Phone ®).

. Use the 5-way navigation control to access your Favorites buttons.

. Highlight the Favorites button you want to edit or delete.

. Press Menu (meny) .

. From the Edit menu, choose Edit Favorites Button (/E).

. Make the desired changes. For example, you can add a Quick Key
shortcut to any favorite. When you press and hold the assigned letter
from within the Phone application, the favorite launches.

. To delete the entry, choose Delete.

. Choose OK.

%
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You can also organize your

Favorite buttons on different
pages. From the Edit menu,
choose Edit Favorites Pages.

You can edit but not delete
the voicemail entry.
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In addition to the headset
that came with your Treo,
you can use other third-
party headsets.

To hear stereo through the
jack (such as music), you
should use a stereo adapter
or other accessory. Visit
www.handspring.com for
more information.

The headset designed for
previous models of Treo is
not compatible with the
Treo 600.

Using a phone headset

You can connect a phone headset for hands-free operation. If you need to
use your phone while driving and this is permitted in your area, we
recommend using a phone headset.

A. Speaker
B. Microphone
C. Headset button

You can press the headset button to perform any of the following tasks:
* answer an incoming call
* answer a call-waiting calll
* switch between two active calls
* hang up a single call

Headset specifications

Your Treo uses a 2.56mm, 3-pin headset connector. Your Treo works with
headsets that are designed for this type of connector. When in doubt, ask
the third-party headset manufacturer if their product is compatible with Treo
phones. If you hear a headset buzz or poor microphone performance, your
headset may be incompatible with Treo.
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Browsing the web

Blazer Web Browser on your Treo provides quick and easy access to web
pages. You can view the regular sites you use today, including those with
security and advanced features like JavaScript and frames. To browse the
web, you must activate data services from your mobile service provider.

Viewing a web page

1. Make sure Wireless Mode is turned on, as described on page 14.

2. Press Applications Launcher @, then choose Blazer.

3. Navigate to the web page you want:

» To view a portal of mobile content designed specifically for your Treo,

choose 1.
To go to any web page on the Internet, choose IZ&#]. If you browse
to a secure web page, a Lock icon 5 appears.
To view the previous or next page, choose 4@ or B,
To refresh the page with the latest content available from the Internet,
choose [&s.

Navigating in Optimized Mode

Blazer uses a patent-pending technology to optimize web pages for your Treo.

By default, the browser reformats web pages into one column on your screen.

This way, you can see most content without needing to scroll left or right.

* Press Up or Down to move through a web page.

» Press Left €4 or Right * to move between links on the page. To follow a
link to another web page, highlight the link and then press Center. You
can also tap the link on the screen with your stylus.

Browsing the web
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Want to get to the icons
faster? Press Option and
Center to jump down to the
icons, or press Menu to
access the same commands
through the menus.

Always using bookmarks?
Make Bookmark View the
default view when you
launch the browser. From
the Options menu, choose
Preferences, then select the
Bookmarks icon as your
Initial View.
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Navigating in Wide Page Mode

Some web pages, such as maps, are easier to view without the optimization
done in Optimized Mode. You may want to view these pages in Wide Page
Mode. This mode presents the web page as you would expect to see it on
your computer’s screen.
1. Go to the page you want to view.
2. Press Menu (meny) .
3. From the Page menu, choose Wide Page Mode (/W).

* Press Up 4, Down v, Left <, or Right  to scroll through the

wide page.
» To follow a link to another web page, tap the link with your stylus.

Creating a bookmark

Bookmarks let you instantly access a web page, without needing to type the
address every time. Blazer can store up to 100 bookmarks or saved pages,
allowing you to open your favorite web pages quickly. Remember, a Blazer
bookmark is different from a Favorite (see page 50).

1. Go to the page you want to bookmark.

2. Press Menu .
3. From the Page menu, choose Add Bookmark (/A).

Mew Bookmark. [i]

Namne:

Handspring

Description:

Welcomne to Handspring.com

Preview: [Handspring
\Welcorne to Hand

. If desired, change the Name and Description.

. Choose OK

. Use the stylus to drag and drop the new bookmark into a slot on the
current page. To move the bookmark to a different page, drag and drop it
on the page icon [H].

. Choose OK.

Saving a page
Blazer lets you save a page for offline viewing, so you don't need an Internet
connection to view it later.

. Go to the page you want to save.

. Press Menu (meny) .

. From the View menu, choose Save Page.

. Choose OK.

. Use the stylus to drag and drop the new bookmark into a slot on the
current page. To move the bookmark to a different page, drag and drop it
on the page icon.

6. Choose OK.

Viewing bookmarks or saved pages

Bookmarks and saved pages both appear in Bookmark view. Saved pages
are indicated by a small triangle in the upper-right corner of the bookmark.
1. Choose the Bookmarks view icon EH.

2. Choose the bookmark or saved page you want to view.

'Bookmarks - il

Handspring
Mobile
hMapquest Directions
Directions to Handspring
Directions Hollywood.co
tolunch 0713 Movies
Yahoo Yahoo
flobile Weather
Amazon.corn  |Handango
Iobile Software

Browsing the web
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Tap and hold the back or
forward buttons to pop up a
list of sites you've visited.
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Editing or deleting a bookmark or saved page

1. From the Bookmarks view, press Menu .

2. From the Bookmarks menu, choose Edit Bookmarks.
3. Choose the bookmark you want to edit or delete.

4. Enter the desired changes.

5. Choose OK.

Arranging bookmarks and saved pages

Blazer includes 10 pages so that you can arrange bookmarks and saved
pages in a logical fashion. For example, you can store travel links on one
page, stock links on another, and business links on third page.

1. From the Bookmarks view, press Menu .

2. From the Bookmarks menu, choose Edit Bookmarks.

Edit Booksnark List

Title: Bookmarks

aoogle EEE-1212
Mapquest

[l Hullywood.corm
‘fahao ‘fahao

Arnazon.corn
==
a1 7] =1 [ 1w

. Type a new title for this page.

. Use the stylus to drag and drop bookmarks into different slots on the
current page. To move a bookmark to a different page, drag and drop it
on the page icon.

. Choose OK.

Downloading files from a web page

Blazer lets you download files that are useable on your Treo, such as new

applications or pictures. When you download a file, it is automatically sent to

the application that can use the file. Note: Only certain images tagged

specifically for download can be downloaded by Blazer.

1. Go to the page that contains the link to the file you want to download.

2. Press Left € or Right » to highlight the link to the file, then press
Center to initiate the download process.

Navigating web sites with split pages (Frames)

Some web sites split their pages into separate areas, each with their own

scroll bars. You can navigate these sites more easily by “zooming in” on

one of the separate areas. To do this:

1. Tap inside the area of the split page you want to make larger. Make sure
you tap on an area that is not a link, otherwise, you will navigate to that link.

2. Tap the magnifying glass icon in the navigation bar & This will make
the area you tapped on the entire page. Note: This icon will only appear
if you are on a page that is split into separate areas.

Copying text from a web page

You can copy text from a web page and paste it in other applications.

1. Use the stylus to highlight the text you want to copy.

2. Press Menu .

3. From the Edit menu, choose Copy (/C).

4. Go to the application in which you want to paste, then position the cursor
where you want to paste the text.

. Press Menu .
. From the Edit menu, choose Paste (/P).

&
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Lots of pretty graphics
slowing you down? Browse
the web faster by turning off
images. From the Options
menu, choose Preferences,
and then check the Don't
Show Images box.

If Blazer does not recognize a
phone number as dialable,
you can copy the phone
number (as text) and paste it
into the Phone Dial Pad (see
tip on page 37).
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Visit secure web sites. The
128-bit SSL, strong
encryption lets you browse
secure sites, such as online
shopping, banking, and
email. Remember: some
secure sites also require
specific browsers, and may
not work with Blazer.
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Using the History list

The History list stores the addresses of the last 100 pages you visited.
ltems in the History list are sorted chronologically.

1. From the Page view, press Menu (meny) .

2. From the Page menu, choose History.

3. Press Down + to navigate through the list.

4. Choose the web page you want to load.

Finding text on a web page

1. From the Page view, press Menu (men) .

2. From the Page menu, choose Find Text on Page.

3. Type the text you want to find.

4. Check or uncheck the Wrap Search box to indicate whether you want the
search to wrap from the end of the page to the beginning when the end
is reached.

5. Choose Find to start the search.

Customizing your Blazer Web Browser settings
1. Press Menu (men) .

2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
* Initial view: Determines which view displays every time you launch

Blazer.
Don't show images: Selects whether you want images to appear
when you load a web page. If you don't view images, web pages will
load faster. If you choose not to view images, you can still see any
image by choosing the placeholder box on the web page.

Home Page:

Advanced Preferences 60

Set limit on memory for
storing recently viewed
poges {cache): 15 ME (59}

Free mermory: 17.2M

Initial View: [B]EE]
E Mernory Managerment

O Don't show images {faster

[ Accept cookies

4. Choose Advanced and set any of the following preferences:

+ Set limit on memory for storing recently viewed pages (cache): Sets
the amount of memory used for your cache. Pages are cached so
they load faster the next time you view them.

Memory Management: Enables you to free up memory on your phone
by clearing the memory for recent pages, history, and cookies.
Set Proxy: Sets up a proxy server to access the Internet. If your
connection requires a proxy server, please contact your Internet
service provider or IT administrator for this information.
Accept cookies: Allows some web sites to store personalized
information on your Treo. Some sites do not work properly unless you
select this option.

5. Choose OK.

&
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Blazer supports JavaScript,
SSL, and cookies, but does
not support plug-ins (Flash,
Shockwave, etc.) or Java
applets.

Email from a web page.
Email addresses appear as
links on web pages. After
you configure an email
application on your Treo,
you can select an email
address link to create a
message to the selected
address.
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To send a picture to
someone at the same time
you save it, choose Send
instead of Save.

You can reduce the size of

an image before sending it.

From the Picture menu,
choose Downsize. Indicate
whether you want to resize
the original or save a
reduced capy.

To view other full-size
pictures, choose Prev or
Next.

Taking pictures with the camera

Your Treo includes a camera that lets you take pictures, send them to other
people as attachments or picture messages, and use them to personalize
your device (such as wallpaper or picture caller ID; see page 112 for details).

You can move pictures to a Windows computer by performing a
HotSync operation. Pictures are 12-bit color at a maximum of 640x480
resolution (0.3 megapixels).

Taking a picture
1. Press Phone ®).
2. Press Right > to launch Camera.
3. Point the lens on the back of your Treo at the subject you want to
photograph.
. Press Center to capture the picture.
. If desired, edit the picture name and category at the top of the screen.
. Choose Save to keep the picture, choose Don't Save to discard it, or
choose Send to send the picture.

[on't Sawve
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Viewing a picture

1. Choose the Pictures view icon i=.

2. Choose the picture you want to view.
3. Choose Done.

Sending a picture

You can send a picture to other picture-enabled mobile phones or to an

email address.

1. From the Pictures view, choose the picture you want to send.

2. Choose Send.

3. If a dialog appears, choose the application you want to use to send
the picture.

4. When the sending application launches, address and send the message.

g

You cannot send pictures
that appear with a lock icon
in the Pictures view.
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You can rename a picture.
From the Picture menu,
choose Edit Name.

Move or copy a picture to
your SD card. Select a
picture, then press Menu.
From the Picture menu,
choose Move, then choose
your SD card from the
pick list. See page 105 for
more information on using
expansion cards.

Moving pictures

1. From the Pictures view, choose the picture you want to move.

2. Press Menu (meny) .

3. From the Picture menu, choose Move (/M).

4. Choose the category or expansion card where you want to move the picture.

B. Choose Move to finish.

[Pictures IIRE ~ Personal

[N Flowers002

R
MMove Pictures

Category: w Business

Deleting a picture

1. From the Pictures view, choose the picture you want to delete.
2. Choose Delete.

3. If prompted, choose OK to confirm deletion.

Customizing your Camera settings

1. From any Camera view, press Menu .

2. From the Options menu, choose Preferences.

3. Set any of the following preferences:

» Default name: Names a series of pictures to be captured, such as

Seattle001, Seattle002, etc.
Category: The default category for newly captured pictures.
Picture size: The default size for newly captured pictures. Large is
640 x 480 pixels, small is 120 x 160 pixels.
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Play capture sound: Plays a sound to confirm picture capture.
Confirm before deleting: If checked, Camera asks if you're sure you
want to delete a picture before erasing it.
Confirm before saving: If checked, Camera asks if you're sure you
want to save a picture before storing it on your Treo.
Backup settings: When activated, backs up the Treo image database
on your desktop computer.

4. Choose OK.

Default name: Flowers
exarmple: Flowers001

Category: v Personal
Picture Size: w Large
O Play capture sound
' Confirm before deleting

® Confirm before saving

Cancel Backup =ettings

Viewing pictures on your computer (Windows only)

When you perform a HotSync operation, your Treo images are copied to

your desktop computer. You can view these pictures in JPEG format, or

email them to friends using your desktop email application.

1. Locate your Pictures folder. This is most likely at C:\Program
Files\Handspring\Treo Pictures\(user name) or if you upgraded from
another Palm Powered device, at C:\Program Files\Palm\Treo
Pictures\(user name).

. Double-click any file to launch it with the default picture viewing software
on your Windows computer.

Taking pictures with the camera
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When entering a message,
you can insert emotive
symbols by choosing
Ematicons or predefined
QuickText phrases by
choosing QuickText and
then selecting a phrase. To
add a new phrase, select
Edit QuickText from the list.

Not all symbols available on
your device may be used in
text messages. The SMS
application automatically
replaces invalid characters
before it sends your
message.

You can address text
messages to multiple
recipients by separating the
addresses with a space or a
comma. If you address a
single message to three
people, you will be billed for
three messages.

SMS

SMS messages are brief notes that you exchange with other mobile phones
that have SMS capability (also known as short messaging). Long messages

with more than 160 characters are split into several messages. Refer to your
service plan for per-message pricing and availability.

Creating and sending a message
1. Make sure Wireless Mode is turned on, as described on page 14.

2. Press SMS @.
3. Choose New.

.Compose Lot

Bob Jones {M}
To: » +1-£50-506-LECE

QuickTesxt

4. If the intended recipient is in your Contacts list, start typing the first initial
and last name (no spaces). Otherwise, type the full phone number or
email address. Destination email addresses are included in the 160
character count.

. Press Down . If you typed just a few letters of the recipient's name,
choose the recipient's phone number or email address from the list that
appears.

. Type your message.

. Choose Send.

Receiving messages

When your phone is on and in an area of wireless coverage, you will
automatically receive SMS messages sent to you. You can configure your
Treo to automatically notify you when new text messages arrive, using a
ringtone and vibration or simply an onscreen alert.

From the New Message alert:

+ To view your message(s), choose Go To.

» To dismiss the alert, choose OK. The message will go straight to the Inbox.
» To be reminded of the new message again in 5 minutes, choose Snooze.

10:57 pin Reminder

New Text Message
From:Dewey Duncan (M)

Message [REIRN Tl I
From: +16505503095
Datez 1011403 4:02 prin

Hi Stuart, coming to the Hey! Check out

meeting at 9 today? --D it tp: ¢ www handspring corn and
thien give e acall ot +1650555 1234
if youwant rore info..

Using links in messages

Cane || Respond

When you receive an SMS message that contains a telephone number,

email address, or URL, you can dial the number, send an email message, or

go to the web page immediately.

1. Choose a message from the list.

2. Choose the phone number, email address, or URL (appears as
underlined blue text).

3. Your Treo automatically launches the appropriate application from the link.




If you are out of a coverage
area or if Wireless Mode is
off, outgoing messages go
into the outbox. When you
return to a coverage area,
messages are sent
automatically.

Choose Save to save a draft
of the message without
sending it. To access the
draft, choose the pick list in
the upper-right corner, then
select Drafts.

Managing your messages

The status icons that appear next to each message in the Inbox, Outbox,
and Sent folders indicate the following:
% Anincoming message. Unread messages appear in bold; messages
you've read appear in plain text.
An item that is locked and cannot be deleted or purged until you
unlock it.
An outbound message that is waiting to be sent.
A chat session. Chats containing unread incoming messages appear in
bold text.
A voicemail or numeric page. An unread voicemail or numeric page
appears in bold.

In list view you can rearrange the messages in any folder using the Sort
command.

1. From list view, press Menu (men) .

2. From the View menu, choose Sort by Name or Sort by Date.

In list view you can delete several messages at once from any folder using
the Purge command.

1. From list view, press Menu (meny) .

2. From the Message menu, choose Purge.

3. Choose the Purge pick list, then select an option.

4. Choose OK.

- Joe

Meet Tomorrow
‘% +16C05EE3E61 5/9
= Hey David, just trvingout T...
- Myron Windorn Y]
@ Schedule Update
[, 16505550800 579
chat thread

Mew Respond

Chatting with SMS

When you exchange more than one SMS message with a single contact,
your messages are grouped into a chat session. The upper part of the Chat
view displays all messages you've exchanged with this contact, and the lower
part provides a text entry area. You can carry on multiple chats at the same
time and easily switch between them, using the pick list at the top of the
screen.

w Eill Davids (M} .
Mle: La Table for dinner tonite?
Bill Davids: Meed to chk w/the client
Mvle: Call oy mobile to confirm.
Bill Davids: Will do. See youat 18:30

"= Quick Text 14 characters

ee vou there, |

[ane (5 Emoticons

1. From the Inbox, choose a chat.
2. Type your message.
3. Choose Send.

Customizing your SMS settings
1. Press Menu (meny) .

2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
* Messages: Your preferences for individual text messages.
* Confirm message deletions: Indicate whether you want deletion

confirmation messages to appear.
Return to list view after deletion: Indicate whether you want to return

to the list view or the next item in the folder after deleting a message.

g

SMS messages can be sent
and received even while
you are on a phone call.
This is easiest when using
the hands-free headset or
speakerphone.

To find the conversations
you had with someone,
open your SMS Inbox and
select a chat session.




Warning: Changing your SIM
preferences may cause the
SMS application to stop
functioning.

» Chat: Your preferences for chat sessions.
» Show timestamps in chats: Indicate whether you want to see the

date and time stamps of each message in the Chat screen.
Display my name in chat window as: Enter the name you want
displayed as the label for your messages in the Chat screen.
Label Color: Select the color in which you want messages to appear.
Use color for: Indicate whether you want to view both the message
label and message in a different color, or only the name.

Preferences

Preferences [i]

Messages | Chat | SIM

Preferences [i]

Wessages | Chat _|(SIN

® Confirm message deletions
O Return tolist view after delete

Addressing new messages:
w Typing enters digits

oK ) (Gre)

IE Show tirmestamps in chats

Display my narme in chat window as;
Me

Label color-w [N

Use color for w name only

WARNING: Changing these
settings may cause this application
+a stop functioning.

Message
center numnber: +12095552030

Ernuail
center numnber: 509874221

» SIM: your preferences for the SIM card in your Treo.
* SMS Message center number: Enter, verify, or update your mobile
service provider's SMS Message Center phone number.
Email gateway: Enter, verify, or update your mobile service provider's
email gateway number. This is required to send SMS messages to an

email address.
4, Choose OK.

MMS

MMS (multimedia messaging) is used for messages consisting of pictures,
text, and sounds presented as one or more pages. You can include any of
the following items:

* Ring tones
* MIDI: Up to 16-voice polyphony (Standard or SP-MIDI format), 64 KB
per sound file
* iMelody: Up to 64 KB per sound file
* Sound clips
* AMR: Up to 30 seconds playback time, 64 KB per sound file
* Pictures
» JPEG: Up to 640 x 480 pixels, 64 KB per image file
» GIF: Up to 640 x 480 pixels, 64 KB per image file

Creating and sending a multimedia message

1. Press Applications Launcher @ .

2. Choose the pick list in the upper-right corner, then select All.
3. Choose the MMS icon.

4. From the MMS list view, choose New.

w To: +1-6E50-555-C00E
Subj: Mew Baby Photos!

Send | (Preview](Cancel ] <

5
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Before you use your Treo fo
send or receive multimedia
messages, consult your
mobile service provider for
pricing and availability of
multimedia messaging
services.

Save a message as a
template for other messages.
From the Compose menu,
choose Save as Template. To
create a message based on
the template, go to the
Template folder and then
choose the template you
want to use.
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A multimedia message may
contain multiple pages. To
navigate between pages or
add a new one, choose the
Page Selector arrows at the
top of the screen.

To stop playback of a

message, choose Play/Stop.

To save a picture from an
incoming message, select it
then press Center. To select
the text of an incoming
message, position the
cursor in the text area then
press Center.

. If the recipient is in your Contacts list, start typing the first few letters of
the recipient's name. Otherwise, type the number of a phone that
supports multimedia messaging, or an email address.

. Press Down . If you typed a few letters of the recipient's name, choose
the recipient's phone number or email address from the list that appears.

. Add ring tones, sound clips, pictures, or text to the message:

» Choose Add Picture to insert a picture. Once a picture is inserted,
choose the picture to edit or remove it.
Choose Sound E]# to insert a ring tone.
Add more pages to your message using the Next Page arrow in the
title bar.
Select the text entry area and type any text you want to include with
the message.

. Choose Preview to view the message as the recipient will see it.

. Choose Send to finish.

Receiving multimedia messages
You can automatically download new messages or have Treo notify you that
a message is ready to download. In either case, an alert appears when you
have a new message.

From the alert:

+ To view your message(s), choose Go To.

+ To dismiss the alert and view the message(s) later, choose OK.

» To be reminded again in 5 minutes, choose Snooze.

10:57 prn Reminder

New Photo Message
;r] From: +16505553595

Select Go To to view it
now.

Viewing/playing a multimedia message

1. From the Inbox, choose the message you want to view.

2. If there are sounds or multiple pages, playback will begin immediately.
3. Use the onscreen controls to scroll to other pages and messages.

4. If a Sound icon &]% appears, choose it to play or save the sound.

5. Choose OK.

A. Previous message
B. Play/Stop

C. Next message

D. Sound icon

E. Playback icon

Responding to a multimedia message

1. From the MMS list view, choose the message you want to view.
2. Choose Respond.
3. Choose the appropriate action to reply, forward, or call.

Managing multimedia messages

You can rearrange messages in any folder using the Sort command.
1. From list view, press Menu .
2. From the View menu, choose Sort by Name or Sort by Date.

In list view you can delete several messages at once from any folder using
the Purge command.

1. From the MMS list view, press Menu (meny) .

2. From the Message menu, choose Purge.

3. Choose the Purge pick list, then select a purge option.

4. Choose OK.

)
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To delete an item from a
message you're creating,
highlight it and then press
Backspace.

You can expand and
collapse header information
by choosing one of the “full
header” icons in the title
bar of a message.

If you reply to a multimedia
message with a text
message, you'll automatically
be sent to the SMS
application to compose your
reply.




Customizing your MMS settings
1. Press Menu (men) .

2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
* Automatically deliver messages: Indicate whether you want to

automatically download incoming multimedia messages.
Even when roaming: Indicate whether you want to automatically
download incoming multimedia messages while roaming.
Confirm message deletion: Indicate whether you want deletion
confirmation alerts to appear.
Display alerts in Privacy Mode: Indicate whether you want the
subject and sender’'s name to appear in the notification alert.
Save copies of sent messages: Indicate whether you want to save
copies of messages you send.
Connection Settings: Indicate whether you want to use the
Automatic or Custom connection settings. If you choose Custom,
choose Edit and enter your settings.

4. Choose OK.

Preferences [i]

| ] Autornatically deliver messages
O Evenwhen rearmning

[ <onfirm message deletion
O Display alerts in Privacy Mode
[ Sawe copies of sent messages

Connection Settings:

Rutornatic
OK Cancel

Sending and receiving
messages with Mall

If you have activated data services (such as GPRS), you're ready to set up
your Treo for email. These steps differ depending on who provides your
email service.

* Mail: The built-in email application on Treo that provides wireless access to
an existing POP3 email account. See the sections that follow for details.
Other mobile email services: Your mobile service provider may offer a
wireless email service to which you can subscribe with your service plan.
Contact your mobile service provider for details.

Third-party email applications: A number of third-party developers offer
Palm OS email applications. Consult the email application’s
documentation to learn how to set it up.

Setting up Mail

The first time you use Mail, you need to set it up on your Treo. If you have

multiple email accounts, you can set up Mail to access more than one

account. To use Mail, you must have:

* Mobile account with data services activated.

* Email account with an email service provider that supports the POP3
protocol. Examples include Tiscali, Wanadoo, and Freeserve. Contact your
email provider to determine if your account is POP3 compatible. If not,
contact your mobile service provider to learn about their corporate email
solutions, or use a third-party solution.

g

The Mail application is
compatible with regular
POP3 email accounts. Other
accounts, such as corporate
or web-only email, require
special applications, if
available.

For quick access to the
Mail application, link it to
one of the buttons on the
front panel of your phone,
such as the Messaging
button. For details, see
page 117.
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To address a message to
several people, separate
each address with a comma
or space. When you're
finished adding addresses
press Genter to finish.

If you receive an error when
sending a message, you
may need to specify an
SMTP server for your email
account, or add other
security preferences before
you can send emails. For
more information, see the
troubleshooting tips on
pages 140-142.

1. Press Applications Launcher @.

2. Choose the Mail icon.
3. Choose the pick list, then select your email service provider. If your email

service provider is not listed, select Other.

Mail Setup a

Select an account to setup

‘ou can configure up ta five
ermail accounts. After vour first

Setup Yahoo a
Enter your personal
information for this account:

Full Mame{e.q. John Doe):

Ernail Addressye.q. john@doe.comn:
@yahoo.com

account setup is complete, wou
can Feturn to this screen. Password

4 Choose Next.

5. Type your Full Name (as you want it to appear when you send messages),

your full email address, and your Password for this account. If you
selected Other from the pick list earlier, choose the tabs for Server and
Advanced, and enter the necessary information. If you do not have this
information, contact your email service provider to obtain it. For SMTP,
enter the regional SMTP server provided by your mobile service provider.
6. Choose OK to continue.
7. Choose Done.

Creating and sending messages

1. From the Inbox, choose New.

2. Begin typing the addressee’s email address, first name, or last name
(depending on how you sort your Contacts list). Mail remembers your
most recent addressees and suggests choices. To accept a suggestion,
press Down . To send to a different address, keep typing the email
address or name.
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3. Enter the subject and message text. To move between fields, press Up
or Down

4. Choose Send to connect and send all messages immediately. Or, choose
Send Later to put this message into your Outbox.

(New I\'Iessuge |

Ta: rhaitani@company.com - Insert Attachment

o
Subj: How about lunch tornorraw?
We could go to that new
rnexican place - what do y
think?

Sent frorn my Treo

m Camera
¢ Sounds

hittped e handspring.com i

i
Send Send Later | | Cancel

Attaching items to your messages

1. Create the message to which you want to attach the item.
2. From the New Message screen, press Menu (meny) .

3. From the Options menu, choose Insert Attachment.

4. Choose the type of item you want to attach.

5. Choose the specific item you want to attach.

Attaching applications to your messages

You can create a new email with a Palm OS application attached (subject to
copyright restrictions).
1. Press Applications Launcher @ .
2. Press Menu .
3. From the App menu, choose Send.
4. Choose the application you want to send. If the application has a lock
icon il next to it, it is protected and can't be forwarded.
. Complete the message and send.

g

To send a copy or blind
capy, choose Cc or Bee,
select those lines and enter
the address(es) in those
fields. See page 80 for
details on displaying the
Bec field.

To save a message without
sending, choose Cancel
(instead of Save), then
choose Yes in the Save
Draft screen.

You cannot attach
Appointments and Contacts
to existing emails, only
new emails.
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You can also reply to all
addressees. Choose the
Respond button, then
choose Reply All.

If you want your Treo to
check your email
automatically, change the
Delivery preference.

Receiving and viewing messages

By default, your Treo will automatically send and receive messages (see
page 79 for more details). You can manually send and receive messages
on-demand as described below.
1. Make sure Wireless Mode is turned on (see page 14).
2. From any mailbox, choose Send and Receive.
3. From the Inbox, choose the message you want to view.
4. When viewing the message text, press Option (7) and Left < or Right
to view the previous or next message.
. Choose Done to return to the Inbox.

B v Inbos 207

(5] Paul Cousineau

great new application
B Paul Cousinzau

svhead

From: Srilla Anderson
Subj: Meet Friday

3 Paul Cousineau

new jersey design FRIDRY

Mo 21, 2003

Weekly Updates: is our project ...

FRespond | [ Delete 4

Kl f4
Yahoo! Picks for May 4, 2.

Send and Receive Delete

Replying to or forwarding messages

When you respond to messages, you can choose whether to include the
original text (see page 80).
1. From the Inbox, Filed, or Deleted folder, open the messages to which you
want to respond.
. From the Message view, choose Respond to reply. To reply to all or
forward, choose the appropriate button.
. Enter your reply.
. Choose Send to finish.
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Viewing attachments

There are a number of attachment types you can open with the built-in
software on your Treo (e.g. ringtones, pictures). You can open other types of
attachments by installing third-party applications. In Message view,
attachments appear with the paperclip icon [l if they are unsupported on
Treo. If attachments are supported on Treo, they appear with the icon for the
associated program (e.g. the camera icon & for pictures).

1. From any folder, open the message with the attachment you want to view.
2. Choose the attachment icon.

3. Follow the prompts from the viewing application.

Managing your messages

The status icons that appear next to each message in your Inbox indicate
the following:

E=d You have not read the message

t=1 You have read the message

W The message includes an attachment

You can rearrange the Mail list to make it easier to find and view messages.

* From the Mail list view, press Menu , then from the Options menu,
choose one of the following: Sort by Date (/Z), Sort by Name (/Y),
Sort by Subject (/J).

» To quickly switch between folders in list view, choose the folder pick list
in the upper-right corner, then select the desired folder.

g

If a large incoming message
is fruncated, go to the
Message menu, then
choose Get Entire Message.

If you have problems
receiving email, see the
troubleshooting tips starting
on page 140.

To hear sound file
attachments, press Menu.
from the Attachments
menu, choose Open.

You can also use the
system Find dialog to
quickly scan your mailbox.
Press Option and Shift/Find.
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To empty (or purge) the
Deleted folder, go to the
Message menu, then
choose Empty Deleted
[tems (/E).

Deleting selected messages from the Inbox

When you delete a message from the Inbox, it moves to the Deleted folder

which stores the 200 most recently deleted messages. If you delete more

than 200 messages, the oldest messages are automatically removed from

the phone.

1. Highlight the message you want to delete. To highlight a group of messages,
press Shift and Up 4 or Down

2. Press Backspace (=) .

3. If a confirmation dialog appears, choose OK to confirm deletion.

Deleting messages by the date

You can quickly delete a group of messages by selecting a range of dates.
. Press Menu .
. From the Message menu, choose Purge (/K).
. Choose a date range for the messages you want to delete.
. Choose OK.
. If a confirmation dialog appears, choose OK to confirm deletion.

Message RNTITE Options

Top of List AT

BottomofList B

=Sortby Date Z
Sort by Name «H

& Yahoo! Weekly Pic.. Sortby Subject )

Yahoo! Picks for May 4. 2. Orange
=Tiscali
Edit Accounts...

Purge Inbox messages
w older than today

Send and Receive Delete

Switching accounts

To switch between different email accounts, press Menu , then from
the View menu, choose an account.
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Customizing your Mail settings

If you have multiple email accounts, you can customize the Mail settings for
each individual account on your Treo. Remember, the preferences you set
will only apply to the email account you are currently viewing.

1. Press Menu (men) .

2. From the Options menu, choose Preferences.

3. Set any of the following Delivery preferences:

*  Get mail: Sets the interval for mail delivery. If you select an automatic
delivery option, you can also select the hours during which you want
automatic delivery.

For each message get: Sets the maximum size for incoming
messages. 1K of information is about 4 screens of text on your Treo.
Only get mail from last ## days: Specifies the timeframe for
retrieving earlier messages.

Auto-deliver even when roaming: Specifies whether you can continue
automatically retrieving your email when you are not in your mobile plan’s
home area (which may incur additional charges on your account). This
option applies only if you selected an automatic delivery option.

Get mai 15

w Weekdays only

For each ressage get w first 10K
w Only getrnail from last 7 days
O Auto-deliver even when roarning

=

@

g

Remember, your Mail
preferences (including
automatic delivery) are set
for the individual account
currently displayed. If you
have multiple accounts,
configure each account
separately.
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Delivery | Delete|| Message Delivery | Delete I\"Iessmjel

[ Confirm message deletion ' Include ariginal text when

o replving
O Return tolist view after
deleting a message [ Include attachriants whan

farwarding
O Always shaw Bee
O Alwayws Bee this address

If you want to access more

than one email account with fl rS-t -tWO Wee kS :

your Treo, choose Add
Account. 4. Choose the Delete tab and set any of the following preferences:

» Confirm message deletion: Asks if you're sure you want to delete a

]
If you 5§Si9” Mail to an message before erasing it.
applcation button, you can * Return to list view after deleting a message: Shows the Mail list view
press and hold that button . )
1o send and receive mal after you delete a message, if checked, or shows the next message in
This is very useful for the list, if unchecked. .
discrest mail checking. 5. Choose the Message tab and set any of the following preferences:
* Include original text when replying: Appends the full text of the

original message when you reply to a message.

Include attachments when forwarding: Sends attachments as well as

the original message when forwarding, even if you cannot open an

attachment on Treo.
Always show Bcc: Displays the Bcc field when creating messages e a u re S
and allows you to pre-fill this field with a default address (useful for

creating a backup copy of email that is sent to your email server).
Signature: Controls what messages have your signature automatically
appended to them and lets you define a custom signature.

6. Choose OK.
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If you have several
appointments to enter, it's
more efficient to use the
Palm Desktop software or
Microsoft Outlook on your
computer and then
synchronize data between

the Treo and your computer.

For more information, see
page 30.

To enter a birthday or
anniversary, create an
untimed event. Then, from
the Details screen, choose
Year as the repeat interval.

82 : Calendar

Calendar

Displaying your calendar

* Press Calendar @) repeatedly to cycle through the various active views.

- REEEE

Use the 5-way navigation control to move to another day, week, or month
(depending on the current view).

Choose Go or press Menu (mens) . From the Options menu, choose Go to
Day (/0), then choose a date from the calendar.

Creating an event

1. Press Calendar @ until you are in Day view.
2. Press Left € and Right * to select the desired day.
3. Using the keyboard, type a starting time for the event. For example, type 53
for 5:30 (Remember to press Option () before typing numbers).
. Press Down + and type the ending time for the event.
. Choose OK.
. Type a description for the event.

C
i Nov 12,03 IKIBRH+DEED

+ Invite John to Dinner
£:00
_[m FPlanning Team meeating
B 10:00
11:00
et A. Selected date
200, B. Starting and ending times

300,
400, C. Selected day

00y

[T (5o) (New

Adding an alarm reminder to an event

1. In Calendar, highlight the event.
2. Choose Details.
3. Check the Alarm box and choose the number of minutes, hours, or days
before the event you would like to receive the alarm.
. Choose OK.

Planning team meeting 6 nov 12,02 IKIBEEvHEES
Timne: #+ Invite John to Dinner

Date:

Alarm: w Minutes —
Repeat: :

Private: O A. Type of time units
Type: [T B. Number of time units

oK ) C. A diamond indicates an untimed event.

Creating an untimed event

An untimed event, such as a birthday or anniversary, does not occur at a
particular time.

1. Press Calendar @ until you are in Day view.

2. Press Left < and Right > to go to the date of the event.

3. Make sure nothing is highlighted.

4. Type a description for the event.

Editing or deleting an event

1. Highlight the event you want to reschedule.

2. Choose Details.

3. Change the date and time as needed, or choose Delete.
4. Choose OK.

©
d

The silent alarm for untimed
events is defined by
minutes, days, or hours
before midnight of the date
of the event.

When an alert occurs, the
Reminder screen displays
all your Treo's pending
alerts. Tap an item's
description to jump to that
item, or check the box to
clear that item.
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Scheduling a repeating event

1. Create an event, then highlight it.

2. Choose Details.

3. Choose the Repeat box, then choose a repeat interval.

4. For weekly events, choose the day(s) the event repeats; for monthly
events, choose Day or Date to indicate the repeating method.

5. If the event has an ending date, choose the End on pick list, then select
Choose Date, and select the ending date.

6. Choose OK.

[Mone [ oy TR Month [ear | 330 Invite John to Rinncr

Change Repeat a

Every: 1 Week{s) o FPlanning Team meeting

Endon: w foEndCate 4 P };Egg
- 00,

Repeat on: [STM[T[W[TF |5 100, A. This icon

2:00, ™

300, indicates a

400, i
o repeating

event.
B TR (Go) (Few) (Betai)

Every weekon Saturday ‘

Customizing general preferences for your calendar
1. Press Menu .
2. From the Options menu, choose Preferences (/R).
3. Set any of the following preferences:
» Start Time and End Time: The beginning and end of the day shown
on Calendar screens.
Event Duration: The default duration of a new event.
Week Start: The day on which the calendar week starts.
Initial View: The view that appears when you launch Calendar.

Button Views: The views that appear when you press Calendar
repeatedly. By default, you see Day and Month Views, but you can also
see other views.

[ Show Time Bars

[ Compress Day Yiew

[ Show PM Label

[ Show End Times

[ Auto-scroll Tirme

O Float Advance at Midnight

[ Show Completed Floating Events

Praferences

Start Time:
End Timne: 6200 prn
Event Duration:
Week Start: w Sun

Initial view: [Jl-]J=[E
Button Views: [l-TEEE

Dizplay Dptions

» Display Options: Your choices for different Calendar view options:
» Show Time Bars: shows the duration of an event and illustrates
conflicts.
Compress Day View: When off, all time slots display. When on,
start and end times display for each event, but blank time slots
disappear to minimize scrolling.
Show PM Label: Displays a p after PM times.
Show End Times: Displays all time bars and time slots for end
times of an event.
Auto-scroll Time: Displays events based on the time of day when
there is more than one screen of information. The arrows at the
bottom-right corner indicate more information.
Float Advance at Midnight: Advances floating events to the next
day at midnight of the current day.
Show Completed Floating Events: Displays completed floating
events.
4. Choose OK to close the Display options dialog.
5. Choose OK.

Calendar ::
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Customizing To Do List preferences for your calendar

You can display To Do List items in your calendar to keep on top of your tasks.

1. Press Calendar @) until you are in Day view.
2. Press Menu .

3. From the Options menu, choose To Do Preferences.
4. Set any of the following preferences:

To Do Preferences [i]

Show Categories:
O Unfiled
O Business
O Personal
Priarities Dizplaved w 1-5
[ Show Priority
O Show Cornplated [terns
O Show Undated Iterns
[ Show Dated tems
w [ Day{s) before Due Date

reate Options

Show Categories: Determines which To Do List categories display.

Priorities Displayed: Limits the To Do List display to certain priorities.

Show Priority: Displays the priority assigned to an item.
Show Completed Items: Displays checked off items.
Show Undated ltems: Displays items that do not have a Due Date
assigned.
Show Dated Items: Displays To Do List items that have a Due Date
assigned.

. Choose OK.

To Do List

You can use To Do List as a reminder of tasks you need to complete and to
keep a record of complete tasks.

Adding a To Do item

. Press Applications Launcher@.

. Choose the pick list in the upper-right corner, then select All.

. Choose the To Do List icon.

. Choose New to create a new To Do item

. Type the text of the To Do item. The text can be longer than one line.
. Press Down + to deselect the To Do item.

IinRenew pussportl

O 1 Book Fredania hotel
O 1 Earthquake insurance
O 2 Send £ to Eddy

2 Buy hockey stick

L lienew passport

O

O 2 Jreck Fredonia hotel
O arthquake insurance
0O hend (D to Eddy

O

o

[m}

[m]

iy hockeny stick
2 Call Mary re pool

2 Robert MIDI keyboard
3 Fix curtain rods

Z Call Mary re pool
2 Robert MID| kevboard
3 Fizo curtain rods

]
O
]
O

[ Mew ) [ Detailz... ) [ Show.. Dietails... ] [ Show...

Setting item priority, due date, and other details

The Details dialog enables you to assign a priority level, due date, category,
privacy flag, and note to each item.

1. Highlight the item to which you want to assign details.

2. Choose Details.

g

To save memory, you can
purge all completed To Do
List items. From the Record
menu, choose Purge.
Choose OK to finish.

You can set To Do List to
record the date that you
completed the To Do item,
and you can choose to show
or hide completed items.
Completed items remain in
the memory of your phone
until you purge them.

You can display To Do List
items in your calendar. See
page 86 for information on
customizing To Do List
preferences for your
calendar.
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To uncheck the selected
item, hold Option and
press Return.

88 :: To Do List

3. Set any of the following:

* Priority: Choose the Priority number for this item (1 is most
important). Later you can arrange your To Do List based on the
importance of each item.

Category: Assign the item to a specific category.
Due Date: Choose the Due Date pick list, then select a due date
for the item.

* Private: Check this box to mark this item private.

* Note: Enter additional text you want to associate with the item.

4. Choose OK.

[Ef Book Fradonia hotel
O 1 Earthquake insurance
O 2 Send 0 to Eddy

O 2 Buy hockey stick

To Do Item Details a
Priovity: [l 2]2]4]5]
Category: + Unfiled
Due Date: w MoDate
Private: [J

0O 2 Call Mary re pool
0O 2 Robert MID keyboard
[ 2 Fix¢ curtain rods

Details.. || Show...

Checking off a To Do item

1. Choose the item you want to check off.
2. Hold Option (*) and press Return (4) .

Deleting a To Do item

1. Highlight the item you want to delete.
2. Press Menu .

3. From the Record menu, choose Delete Item (/D).
4, Choose OK.

Customizing To Do List

The To Do Preferences screen enables you to control the appearance of the
To Do list screen.

1. In the To Do list screen, choose Show.

2. Set any of the following preferences:

To Do Preferences [i]

Sortby: w Priority, Due Date

' Show Completed ltems
[ Show Only Due ltems
O Record Completion Date

O Show Due Dates
[ Show Priorities
O Show Categories

Sort by: Indicates the order in which your To Do items appear in the list.
Show Completed Iltems: Displays items you've checked off.
Show Only Due ltems: Hides items that are not yet due.
Record Complete Date: Replaces due date with the completion date
when you complete (check) the item.
Show Due Dates: Displays item due dates, and inserts an
exclamation mark next to overdue items.

» Show Priorities: Displays the priority setting for each item.

» Show Categories: Displays the category for each item.

. Choose OK.

g

Press Menu to access other
features such as importing

phone numbers into the To

Do list.

If you turn on the Show
Due Dates option in the To
Do Preferences screen, you
can tap directly on the due
date in the To Do List to
choose a new date.
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Each Memo Pad item can
include 4,096 characters of
text.

You can assign categories
to Memo Pad items. Open
the item you want to
change, choose the pick list
in the upper-right corner,
then select a category.

90 : Memo Pad

Memo Pad

Memos are a great way to store notes on your Treo.

Creating a memo
1. Press Applications Launcher@.

2. Choose the pick list in the upper-right corner, then select All.

3. Choose the Memo Pad icon.
4. Enter the text you want to appear in the memo.
5. Choose Done.

‘Memo 105 of 105 Tintiled

Details

Deleting a memo

1. Choose the memo you want to delete.

2. Press Menu .

3. From the Record menu, choose Delete Item (/D).
4. Choose OK.

CityTime

The CityTime world clock displays the day and time in your home city and in
four other cities around the globe. Whether you're travelling or at home, it's
easy to keep track of the best time to reach your business associates,
friends, and family in far away places.

Setting your Home City

The Home City serves as a point of reference for your other city selections.

The Home City time reflects the current system time (unless you have
changed locations, see page 92). The information displayed for all the
other cities is based on the day and time in your Home City.

. Press Applications Launcher@.

. Choose the pick list in the upper-right corner, then select All.

. Choose the CityTime icon.

. Press Menu .

. From the Options menu, choose Select Home City (/H).

. Choose the Home City pick list, then select the city closest to your

location (in the same time zone).
. Choose OK.

.(ityTimg San Francizco &:00 prn + A

e g

w Mew York iw London
Fr %00 prm Sa.2:00 am®

Sa 300 arm®

A. Home City

CityTime
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CityTime does not
automatically update the
system time for Daylight
Savings Time.

Run your stylus over the
map to see the time in
other cities.

The shadow over the map

represents nighttime moving
across the globe.

92 i CityTime

Selecting remote cities

In addition to your Home City, you can display the day and time for four

other cities anywhere around the globe. These other cities are called

remote cities.

1. Use the stylus to tap a pick list in the lower part of the CityTime screen,
then select the city closest to the city you want to display.

2. Choose the remaining pick lists, then select the other three cities you
want to display.

Adding cities

If the city you want to display is not in the predefined list, you can add it.
1. Press Menu (meny) .

2. From the Options menu, choose Edit Cities (/E).

3. Choose New.

4. Enter the city name and other information.

5. Choose OK.

Changing locations

If you travel, you can easily coordinate the system time on your Treo with the
local time.

1. Press Menu (meny) .

2. From the Utilities menu, choose Change Location (/L).

3. Choose the To pick list, then select your new location.

4. Choose OK.

Calculator

Calculator includes a basic calculator, plus an advanced calculator with
scientific, financial and conversion functions.

Switching between Basic and Advanced Calculator modes

1. Press Menu (meny) .
2. From the Options menu, choose Toggle Mode (/M).

Selecting functions in Advanced Calculator mode

1. Switch to Advanced Calculator mode (see above).
2. Choose the pick list near the upper-left part of the screen, then select
the Advanced Calculator function you would like to use:
* Math: Advanced mathematical functions such as exponents, roots
and logarithms.
Trig: Trigonometric functions such as sine, cosine, tangent and variants.
Finance: Financial calculator functions such as APR and amortization.
Logic: Hexadecimal characters in keypad, plus logic functions such
as and, not, or and xor. In place of Float/Degrees (see below), this
view includes options for class (bin, oct, SDec, UDec, hex) and bits
(8, 16, 32).

¢

You can tap the screen or
use the keyboard to input
numbers.
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Choose Sto to store a
number in one of ten
memory slots. Choose Rl
to recall a stored number.

Choose Con to access a list
of mathematical constants
such as Avogadro's number
or the speed of light.

94 :: Calculator

Statistics: Statistical functions such as sum, factorial and random
number generator.

Weight/Temp: Weight and temperature conversions for metric and
English values.

Length: Length conversions for metric and English values.

Area: Area conversions for metric, traditional and English values.
Volume: Volume conversions for metric and English values.

. Choose the pick list near the upper-middle of the screen, then select

how to display decimal values:

Float (Floating point): Position of decimal point varies according to
calculation results.

Fixed(x) (Fixed point): Enter an integer for the number of decimal
places to display, then select Fixed(x) to round calculations to that
decimal place.

Sci(x) (Scientific notation): Enter an integer for the number of
decimal places to display, then select Sci(x) to round calculations to
that decimal place using scientific notation.

Eng(x) (Engineering notation): Enter an integer for the number of
decimal places to display, then select Eng(c) to round calculations to
that decimal place using engineering notation.

. Choose the pick list near the upper-right of the screen, then select

whether you want to display numbers in degrees, radians or grads.

Looking up contacts and other
information

With the built-in search features on your Treo, you can find information quickly:

* Name Lookup: Enables you to dial your Contacts by name. It locates
people’s phone numbers when you're in the Contacts list.

* Find: Searches through the text in all the applications on your Treo,
always starting with the current application.

Name Lookup
You can access Name Lookup directly from the Contacts list. This feature
helps you locate Contacts quickly by entering just a few letters of a
Contact's name.
1. Press Phone ®).
2. Use the 5-way navigation control to access the Contacts list.
3. From the Contacts list, enter the first few letters of the Contact you want
to find. You can enter:
«  First name (JOH for John) or
« Last name (SMI for Smith) or
First name initial and last name (JSM for John Smith)

~ Fill Tl 4

4085554213 H

14155557842 W

Mew Contact ] (fessage]

Looking up contacts and other information

g

To access Name Lookup in
other applications, choose
the Lookup button if it
appears.
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To search by company for a
name you can't remember,
open Find, and type the
name of the company.

Find is not case-sensitive
and it locates any word that
begins with the text you
enter. For example, entering
plan finds planet, but not
airplane.

Find searches through one
screen's-worth of
information at a time. At
first, you may see search
results from one application,
or several. If you don't find
what you need on the first
screen, choose Find More to
check other applications.

For example, entering SM displays Smilla Anderson, John Smith, and
Sally Martin as shown above. Entering JSM finds only John Smith.
4. Do one of the following:
+ Highlight the contact name, then press Center to view the contents
of the record.
» Highlight any phone number, then press Center to dial.

Using Find

The Find feature locates any text in the built-in applications and databases,

and in some third-party applications. The Find feature performs an exact

search on a character string, including characters that are parts of words.

1. Press Option () then Shift to open the Find dialog.

2. Enter the text you want to find.

3. Choose OK to start the search.

4. In the search results, choose the text you want to review, or choose Find
More to search additional applications.

| Matches for “birthday™ |

alendar
day

t ' early

'z birthday Yearly
Caralyn's Birthday fearly
Karen Hwa's Birthday fearly
Dad's birthday Y early
‘fuko's Birthday Y early
Maoke's Birthday Y early
‘ukari's Birthday Y early
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Beaming information

Your Treo is equipped with an IR (infrared) port that lets you beam information
to another Palm Powered device with an IR port. The IR port is located on the
top of your Treo, between the Wireless Mode button ) and the ringer switch,
behind the small dark shield.

Beaming a record

1. Choose the record or category you want to beam.
2. Press Menu .
3. From the Record menu, choose one of the following:
* Beam (B): Sends an individual record.
+ Beam Category (/Y): Sends all records in the current category.
. When the Beam Status dialog appears, point the IR port on your Treo
directly at the IR port of the receiving device.
. Wait for the Beam Status dialog to indicate that the transfer is complete
before you continue using your Treo.

‘~

=

g

You can store a beamed
application on your phone,
or send it to an expansion
card inserted in the
expansion slot.

Beam your business card in
two ey presses: in any
Phone view, press Menu,
then press M.
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Beaming an application

Not all applications can be beamed. A lock icon i@ appears on the Beam
screen next to applications that cannot be beamed.

1. Press Applications Launcher@.

2. Press Menu .
For best results, the path i From the App menu, choose Beam (/B).

hetween the two devices . Choose the Beam From pick list, then select whether the application you fl rS-t I I I O n -t h :

must be clear of obstacles, want to beam is located on your Treo or an expansion card.
and both devices kept . Choose the application you want to transfer.

1
stationary. If you have . Choose Beam.
dificulty beaming, shorten . When the Beam Status dialog appears, point the IR port on your Treo
the distance and avoid . y .
directly at the IR port of the receiving device.

bright sunlight. ] i e )
. Wait for the Beam Status dialog to indicate that the transfer is complete

g

If you do not choose a before you continue using your Treo.

| [ |
category upon receiving a
beamed item, the item is Receiving beamed information | I
placed in the Unfiled

1. Turn on your screen.

2. Point the IR port on your Treo directly at the IR port of the transmitting
device to open the Beam Status dialog.

3. When the Beam dialog appears, choose a category for the entry.

4. Press Up 4. to receive the beam or press Down + to refuse it.

category.
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On a Windows computer, you
can also access the Install
Tool dialog by selecting
Install Tool under Handspring
on the Start menu or from
the Programs folder.

Installing applications

Your Treo comes with several applications built-in and ready to use. You can
also install third-party Palm OS applications, such as business software,
games, and more. To learn more, go to www.handspring.com/software.

When you download an application to your computer, it is probably in a
compressed format such as a .zip or .sit file. If the file is compressed, you
need to use a decompression utility on your computer, before you install
applications on your Treo.

These instructions tell you how to install basic .prc (Palm OS application)
and .pdb (Palm OS database) files onto your Treo. Some Palm OS software
uses an installer or wizard to guide you through the process. Consult the
documentation that came with the software for details.

Installing applications from the Internet

You can install Palm OS applications directly from the Internet, using the

Blazer web browser. When you download an application, it automatically

installs on your Treo. Remember: Palm OS applications have .prc or .pdb at

the end of their file names.

1. Launch the Blazer web browser (see page 53).

2. Go to the page that contains the link to the application you want to
download.

. Press Left < or Right I to highlight the link to the file, then press

Center to initiate the download process.

100 :: Installing applications

Installing applications from a Windows computer

1. Double-click the .prc or .pdb file you want to install on your Treo.
2. A dialog may appear with a User drop-down list. Select your User Name
from the list.

. The Install Tool window appears. If you would like to install additional
files, simply drag and drop them into the space in this window.

. If you want to install an application to an expansion card, click Change
Destination. Click the arrows to move the application to the expansion
card pane, then click OK.

. Click Done.

. Perform a HotSync operation to install the application(s) on your Treo.

48 Install Tool B

Uszer: I Rab

Filelz] listed below will be installed on your handheld the nest
time you perform a HotSyne operation:

File Mame | File: S\ze| Destination
@HAHDBALL PRC 24kB B Handheld

Bemave..

Done |

Lhange Destination. .. |
~Tipz:

@ Find other applications ta install on your handheld at

hittp: / Awavars handspring.com

The 'Add’ button looks first in the “AD0-0M folder inside your
C:APROGRAM FILESSHANDSPRING folder. This folder is &
conwvenient place to store downloaded handheld files.

&)

g

Before you can install an
application on your Treo,
you need to have the Palm
Desktop synchronization
software installed on your
computer (see page 29).
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8oce Install Handheld Files

User: -Jeremv ?

a] =
File Size Destination
[

Add Ta List

£
=

— Tips! :
| The fles in this st wil be installed  To add s to this list, either drag-  To find other third party applications |
| on your hancheld device the next  and-drop them anto this window, or  and files for your handheid device,

| time you perform 3 HotSyne click the "Add" buttan. check out cur web site at

| operation et/ wwwehandspring.com

Installing applications from a Macintosh computer

1. On your Macintosh, launch Palm Desktop.
2. From the HotSync menu, choose Install Handheld Files.
3. Select the User Name that corresponds to your Treo phone from the
User drop-down menu.
. Click Add To List.
. Locate the .prc or .pdb file you want to install on your Treo. Highlight it
and click Add File.
. Perform a HotSync operation to install the application(s) on your Treo.

Getting help with third-party applications

If a you encounter a problem with a third-party application (such as an error
message), contact the application’s author or vendor. For general
troubleshooting of third-party applications, see page 145.

Installing applications

Removing applications

If you decide that you no longer need an application, or want to free up
memory on your Treo, you can remove applications from your Treo or an
expansion card (for more on expansion cards, see pages 105-108). You can
remove only applications, patches, and extensions that you install; you cannot
remove the built-in applications that reside in the ROM portion of your Treo.
1. Press Applications Launcher @ .
2. Press Menu (meny) .
3. From the Options menu, choose Delete (/D).
4. If you want to remove an application from an expansion card, insert the
card into your Treo.
. Choose the Delete From pick list, then select the location of the
application you want to remove.
. Choose the application that you want to remove.
. Choose Delete to finish.
. Perform a HotSync operation to remove the application from the Backup
folder on your computer.

If the application re-appears on your device, you

P ot 220 may need to manually delete it from your
computer. Locate your Backup folder on your
g computer (Windows: C:\Program
SIS Messages 86K Files\Handspring\user name; Macintosh: Mac
I HD\Applications\Palm\Users\user name). If you
find a .prc or .pdb file for the application you just

System Ring Tones 3K
Web Cookies 1K |
removed, delete the file from the Backup folder.

&
4

Some applications are
factory-installed in your
phone and cannot be
deleted. These are listed with
a lock icon next to them.

If you upgraded from a
previous version of Palm
Desktop software, your
backup folder may be
located in the Palm folder.

Applications deleted from
your phone are kept on
your computer, in the
Archive folder of your user
folder.

Removing applications :: 103




Using Application Info Using expansion cards

The Info screens display basic statistics about the applications on your Treo. The expansion slot on your Treo enables you to add Secure Digital (SD) @
1. Press Applications Launcher @. cards and MultiMedia Cards (MMC) to extend the storage capacity of your
2. Press Menu . Treo. For example, SD or MMC expansion cards can store: SD cards are faster than
3. From the App menu, choose Info. * Pictures MME cards for reading and
4. At the bottom of the screen, choose the type of information you want * MP3 audio files Witing date

to view: * Games When not using the

» Version: The version numbers of applications on your Treo. » eBooks expansion card, reinsert the

* Size: The size (in kilobytes) of applications and data on your Treo. * Applications mock card to keep the

* Records: The number of records in different applications on your Treo. » Databases expansion slot clean.
5. Choose Done. * ..and more
Device:  Phone Although expansion cards are sold separately, your Treo includes a mock,
— T2 non-functional card inside the expansion slot. When you do not have a
Pty el | functioning card inside the expansion slot, reinsert the mock card to protect

AreaCodes 23K H
Backup 91K the slot opening.

Beam Box 14K
Blazer Cache 1265K
Calc 2K

Inserting and removing expansion cards
-.m -Version Size -Records

1. Press down and release the mock card.
2. After you feel the expansion slot eject the mock card, remove the card
from the expansion slot.
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When you insert an
expansion card, the card
name appears as a
category with a card icon
next to the name. To switch
between the applications on
the expansion card and
your phone, choose the
category pick list in the
upper-right comer, then
select another category.

In order to run an
application on an expansion
card, you must have
enough free space in the
internal memory of your
Treo to accommodate the
program.

3. Hold your Treo with the screen facing you and the card with the notch in
the lower-right corner next to the camera lens.

4. Insert the card into the expansion slot until you feel the card lock into
place and hear the confirmation tone.

A. Notch
B. Camera lens

Launching applications on an expansion card

After you insert an expansion card in the expansion slot, you can launch any

of the applications stored on the expansion card.

1. Insert the expansion card into the expansion slot. The Applications
Launcher automatically appears.

2. Choose the icon for the application you want to launch.

3. Press Center to launch the application.
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Copying applications to an expansion card
You can copy applications between your Treo and your expansion card.
1. Press Applications Launcher @.
2. Press Menu .
3. From the App menu, choose Copy (/C).
4. Choose the Copy To pick list, then select the destination: card name,
or Phone.
. Choose the From pick list, then select the location of the application you
want to copy: card name, or Phone.
. Highlight the application you want to copy.
. Choose Copy to finish.

Copy [i]

Copy To: w Bard

Device: w Hdard

Free Space: 5910 of 5940

[ ]
Call Buddy 114K
MNP Ring Tones Pixer d 183K
SMS Messages

Sub Hunt

System Ring Tones
Web Cookies

From: w Phone

(_Dore ] [Version JEEEN Wore..]

Viewing expansion card information

The Card Info application displays general information about the expansion
card that is currently in the expansion slot

1. Press Applications Launcher @ .

2. Choose the pick list in the upper-right corner, then select All.

3. Choose the Card Info icon.

g

Before you copy an
application to an expansion
card, make sure that it is
compatible with Palm 0§
version 5.2 or higher. Some
applications do not work with
expansion cards and do not
allow you to store data files
in a location that is separate
from the application.
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Renaming an expansion card
If you change the contents of an expansion card, you may at some point
want to rename the card to better match its contents.
1. Insert the expansion card into the expansion slot. The Applications
Launcher automatically appears.
Choose the Card Info icon.

when you're ready:

. From the Card menu, choose Rename Card (/R).

. Type a new name for the card.

[ | |
. Choose OK. _t
Formatting an expansion card C u S O I I l I Z I I l g

Formatting an expansion card is similar to formatting a disk on a computer.
When you format an expansion card, you erase all the data stored on the card.

1. Insert the expansion card into the expansion slot. The Applications
Launcher automatically appears.

. Choose the pick list in the upper-right corner, then select All.
. Choose the Card Info icon.

. Press Menu .

. From the Card menu, choose Format Card (/F).

. Type a new name for the card.

. Choose OK.
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You can also adjust the
ringer volume by pressing
the volume buttons when a
call is not in progress.

Want more ring tones? You
can download them from
the web to your phone (see
page 57).

110 :: Phone settings

Phone settings

Selecting ring tones and messaging alert tones

You can set different tones and volumes for incoming phone calls, Calendar
alarms, and Mail, MMS, and Messaging alerts.
. Press Applications Launcher@.
. Choose the pick list in the upper-right corner, then select All.
. Choose the Prefs icon.
. Choose the pick list in the upper-right corner, then select Sound.
. Choose the Application pick list, then select Phone, Mail, Calendar, MMS,
or Messaging.
. Choose the Volume box.
. Choose each pick list, then select an alert volume.
. Choose the Tones box.
. Depending on the application, select alert tones from the pick lists
that appear:
* Phone
* Known Caller Tone: An incoming call from someone in your
Contacts or Favorites.
Unknown Caller Tone: An incoming call from someone identified
by Caller ID who is not in your Contacts or Favorites.
Roaming Tone: A special tone for incoming calls when you're
outside your home mobile network.
Voicemail Tone: A new voicemail.
Service Tone: A warning of a service change, such as moving
into and out of a mobile network coverage area.

Preferences w Sound

Sl Calendar

= MME
D—' Sound Mod oM
Vibrate: v Off

L5 Sound Mode OFF
Vibraote: v On

Tips...

* Mail
* Message Tone: A message arrives with automatic delivery
» Calendar
* Alarm Sound: The tone played the first time your alarm goes off
* Reminder Sound: The tone played if an alarm is not
acknowledged and the alarm repeats itself
Play Sound: The number of times an alert tone will play during
the alarm sequence
Repeat Alarm: The number of times the alarm repeats itself if not
acknowledged
Every: The interval between alarm repeats if not acknowledged
Alarm Preset: A default for the number of minutes, hours, or days
before the event that the alarm goes off
+ MMS
* Message Tone: A new MMS message arrives
* Messaging
* Message Tone: A new text message arrives

Adjusting call volume

While a call is in progress, or while using the personal speakerphone, press
the volume buttons on the side of your Treo to adjust call volume.

%

g

You can also preview, send,
and delete sounds on your
phone. From Sound
Preferences, choose the
Tones box. Choose Manage,
then choose Play, Send, or
Edit to perform the
corresponding action.
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If you prefer to use the
onscreen Dial Pad, assign

Assigning a caller ID picture

Press Phone (¥).

Press Up to access your Favorites buttons.

Highlight the Favorites button you want to give a picture caller ID.
Press Menu .

From the Edit menu, choose Edit Favorites Button (/E).
Choose More.

System Sound settings

You can immediately silence all sounds on your Treo, including phone ring
tones, Calendar alerts, and system sounds. This does not mute the speaker

on your Treo during a phone call.

If the ringer switch is set to

no sound, the ringer setting
overrides the sound settings
and all sounds are turned off,

the Dial Pad as the default 1. Slide the ringer switch to Sound Mode Off.

wallpaper. 2. To hear all sounds again, slide the ringer switch to Sound Mode On.

l - ] When you slide the ringer switch back to the Sound Mode On position, it
O Dial Extra Digits autematically restores the previous sound settings. For example, if the Phone ring volume
is set to 7 and you slide the ringer switch to Sound Mode Off, you will not alarm that vibrates when the
hear the phone ring. When you move the ringer switch back to Sound Mode ringer switch is set to Sound
On, the Phone ring volume is still set to 7. Mode Off

If you remove the Dial Pad
as the wallpaper, you can
still access it quickly. Press
Phone, then press center.
Dial Pad is always the first
selection in your redial list.

Your Treo includes a silent

Ringtone: » Default
M Image: "oy
Irage

Choose Select Image.
Choose the picture you want to assign to the selected Favorites button.
. Choose Select.
. Choose OK.

Choosing Wallpaper for the Phone screen

If you have images stored on your Treo, you can select different wallpaper
for the Main view in the Phone application.

. Press Phone ®).

. Press Menu .

. From the Options menu, choose Display Preferences.

. Choose the pick list at the top of the screen, then select Show Wallpaper.

. Choose a Wallpaper image for your Phone screen.

. Choose OK.

A. Sound Mode On
B. Sound Mode Off
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Display and appearance

Turning on the keyboard backlight

1. Press Option () then (). The backlight illuminates the keys, and the
screen dims slightly.
2. The backlight will turn off if the keyboard is not in use.

Adjusting the contrast and brightness

Depending on the lighting conditions in which you're using your Treo, you may
need to adjust the screen contrast and brightness. In darker environments, it
may be easier to view the screen when the screen backlight is turned on.

. Press Applications Launcher@.

. Choose the pick list in the upper-right corner, then select All.

. Choose the Prefs icon.

. Choose the pick list in the upper-right corner, then select Display.

. Choose the -#: slider, and use Left < and Right I to adjust brightness.

. Choose the (¥ slider, and use Left < and Right > to adjust contrast.

Display and appearance

Changing the screen font

You can change the screen font in Calendar, Contacts, Memo Pad,
Messaging, and To Do List.

1. Launch the application in which you want to change the font.
2. Press Menu .

3. From the Options menu, choose Font (/F).

4. Choose a font style:

| Selectfont | Small font
A

c .
Font: _ A . Small bold font
B D :

. _ Large font
0K [ Cancel ) Large bold font

5. Choose OK.

Aligning the touchscreen

Occasionally, your Treo touchscreen may need to be readjusted. If this
occurs, you may see the wrong feature being activated when you tap the
screen. To fix the problem, you can recalibrate the touchscreen any time.
1. Press Applications Launcher @ .

2. Choose the pick list in the upper-right corner, then select All.

3. Choose the Prefs icon.

4. Choose the pick list in the upper-right corner, then select Touchscreen.

B. Follow the onscreen instructions.

Changing the system color scheme

1. Press Applications Launcher @.

2. Choose the pick list in the upper-right corner, then select All.

3. Choose the Prefs icon.

4. Choose the pick list in the upper-right corner, then select General.
5. Choose the Colors pick list, then select a color scheme.

Display and appearance ::
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The Applications Launcher
displays each application as
an icon, or you can view
them as a list.
. Press Applications
Launcher.
. Press Menu.
. From the Options menu,
choose Preferences (/R).
. Choose the View By pick
list, then select List.
. Choose OK.

To create a new category,
choose the category pick
list, then select Edit
Categories. Choose New,
then enter the category
name. Choose OK to close
the dialog, then choose OK.

Applications Launcher settings

Arranging applications by category

You can assign an application to a category and then display a specific
category of applications in the Applications Launcher.

1. Press Applications Launcher@.

2. Press Menu (men) .
3. From the App menu, choose Category (/Y).

Merno Pad

&

Prne Security
SIM Boak  SIM Srves SMS

# £ D

ToDoList  Tutorigl  Welcome

4. Choose the pick list next to each application, then select a category.
5. Choose Done.

Displaying applications by category

Do one of the following:

* Press Applications Launcher @ repeatedly to cycle through the
categories.

» Choose the pick list in the upper-right corner, then select a category.
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Button settings

Buttons Preferences

Buttons Preferences let you choose which applications are associated with
the buttons on your Treo.

. Press Applications Launcher @.

. Choose the pick list in the upper-right corner, then select All.

. Choose the Prefs icon.

. Choose the pick list in the upper-right corner, then select Buttons.

. Choose the pick list next to the button or key combination you want to

re-assign, then select an application.

.Preferences  Buttons .Preferences ¥ Default apps

Fressh Option+ Select the default application to
ress button | Button use with each function.

Q% w Phone w Internet

w Calendar  Mema Pad

& v sms * Mail

Emnail ~ Mail
Messaging » 505
Browsaer w Internet

- w Power Keyquard

Cefoult || HotSyne...

Setting default applications

Sometimes, one application looks for another application to handle data (for
example, a mail application might launch a browser when you choose a link in
an email message).

. Press Applications Launcher @ .

. Choose the pick list in the upper right corner, then select All.

. Choose the Prefs icon.

. Choose the pick list in the upper-right corner, then select Default Apps.

. Choose each pick list, then select the application you want to associate

with that function.

g

You can also pick an
application to launch from
the HotSync button on the
cable.

To restore all of the buttons
and key combinations to
their factory settings, choose
Default.
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If you check the box for

Enable Local Network Time,

your Treo displays the time
set by the mobile network.

Date and time settings

Setting the date and time

Date & Time Preferences enable you to set the time, date, time zone, and
daylight savings setting for your Treo.
. Press Applications Launcher@.
. Choose the pick list in the upper-right corner, then select All.
. Choose the Prefs icon.
. Choose the pick list in the upper-right corner, then select Date & Time.
. Choose the Set Date box. Highlight the current year, month, and date,
then press Center to set the date.
. Choose the Set Time box. Using the stylus, tap the up and down arrows
to select the current time, then choose OK to set the time.
. Choose the Set Time Zone box. Choose the time zone for your location,
then choose OK to set the time zone.
8. Choose the Daylight Saving pick list, then select On or Off.

.Preferences  Date & Tirme

O Enable Local Network Time
SetDate:
Set Tirne:

Set Tine Zone:

Daylight Saving:

118 1 Date and time settings

Setting date and time formats
Formats Preferences enable you to choose number conventions based on
geographic regions. For example, in the United Kingdom, time often is
expressed using a 24-hour clock. In the United States, time is expressed
using a 12-hour clock with an AM or PM suffix. All the built-in applications
on your Treo use the Format Preferences settings.

. Press Applications Launcher @.

. Choose the pick list in the upper-right corner

. Choose the Prefs icon.

. Choose the pick list in the upper-right corner, then select Formats.

. Set any of the following preferences:

* Preset to: The standard number conventions for your country. When you
select a country, the other Formats Preferences are automatically set to
that country’s conventions. You can also edit each option individually.
Time: The time format. Select HH:MM to display a 24-hour clock.
Date: The date format.

Week starts: The first day of the week (usually Sunday or Monday).

* Numbers: The format for numbers with decimal points and commas.

Preferences

Preset to: ; United States:

Timne: w HH:MW amspri
754 am
Date: w [0S
11/5/02
Mo &, 2003
Week starts: w Sunday

Numbers: « 100000

g

The Week starts setting
controls the Day, Week,
Month, Year, and List views
in Calendar and all other
aspects of your phone that
display a calendar.

Date and time settings 1 119




g

The Auto-off setting
conserves battery power by
turning off your phone’s
screen. It does not turn off
Wireless Mode so you can
still receive calls, email, and
text messages after the
automatic shutoff period.

The system and game
volume settings apply when
the ringer switch is set to
the on position.

General Preferences

General Preferences enable you to set the auto shutoff interval, the beam
receive feature, sounds, and screen colors for your Treo.

1. Press Applications Launcher@.

2. Choose the pick list in the upper-right corner, then select All.

3. Choose the Prefs icon.

4. Choose the pick list in the upper-right corner, then select General.

.Preferences w General

Auto-off After: + 2minutes
System Sound: w High
Alarm Sound: w High
Gamne Sound: + High
Beam Receive: w On

Colors: w Original

. Set any of the following preferences:
» Auto-off After: The time that elapses before your screen turns off

automatically.
System Sound: The volume for system beeps and alerts.
Alarm Sound: The volume for Calendar and To Do List alarms and alerts.
Game Sound: The volume for game sounds.
Beam Receive: The setting for whether you want your Treo to receive
beamed information.
Colors: The set of predefined colors for the system display.

120 : General Preferences

Locking your phone and data

Your Treo includes several features that help you protect your phone
from inadvertent use and keep your data private. The built-in security
software enables you to use your Treo for emergency calls even if the
handset is locked.
» Keyguard: Manually disables all buttons and the touchscreen to prevent
accidental presses in your briefcase or pocket.
Auto-Keyguard and touchscreen lockout: Automatically enables
Keyguard after a period of inactivity, and lets you disable the touchscreen
during an active call or call alert.
Phone Lock: Requires a password to make and receive calls with your
SIM card.
System password lock: Requires a password to see any data on your Treo.
Private records: Masks or hides items marked as private, and requires a
password to view them.

Keyguard

Your Treo includes a feature that locks the keyboard, so that you don't

accidentally press buttons or activate screen items while the phone is in a

pocket or bag.

1. With the Treo screen on, press Option () and the Screen button @& to
enable Keyguard.

2. To disable Keyguard, press and hold Center.

o
4

When you receive or make
a call, the touchscreen on
the Active call screen may
be automatically disabled to
prevent accidental
termination of a call. You
must use the 5-way
navigation control to access
the buttons on the Active
call screen. Check the
Keyguard Preferences
settings.
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To change your password,
choose the Password box,
enter your current
password, then enter the
new password. To delete
your password, choose the
Password box, then choose
Unassign.

Important: If your SIM card
is locked and you enter the
wrong PIN more than three
times, your SIM will be
blocked, and you must call
your mobile service provider
for your unique PUK (Pin
Unlock Code).

Auto-Keyguard and touchscreen lockout

Auto-Keyguard lets you automatically lock the keyboard after a period of
inactivity.
1. Press Applications Launcher@.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Keyguard.
5. Set any of the following preferences:
* Auto-Keyguard: The period of inactivity that passes before the
keyboard automatically locks.
Disable touchscreen when: The conditions under which the
touchscreen disables.

Phone Lock

You can lock your SIM card to prevent unauthorized use of your mobile
account. When your SIM card is locked, you must enter the correct PIN
code to unlock it, even if you move it to a different phone.

. Press Phone ®).

. Press Menu .

. From the Options menu, choose Phone Lock (/L).

. Check the Lock SIM box.

. When prompted, enter the current PIN and choose OK. Unless you
changed your PIN code, enter the default PIN code, provided with your
mobile service provider's account materials.

. If you want to change the PIN, choose Change PIN, enter a new PIN,
then choose OK to accept it. Repeat this step to verify the new PIN.

. Turn Wireless Mode off to activate the phone lock feature.

. To turn Wireless Mode on again, press and hold the Wireless Mode
button (), enter your PIN, then choose OK to unlock your phone.

122t Locking your phone and data

Your SIM card locks again when you turn off Wireless Mode and then turn it
back on. To permanently unlock your SIM card:

1. Press Menu .

2. From the Options menu, choose Phone Lock (/L).

3. Uncheck the Lock SIM option.

4. When prompted, enter the current PIN and choose OK.

System password lock

To protect your personal information, you can lock the system so that you
need to enter your password to access any of your data or use other
features of your Treo.
. Press Applications Launcher @.
. Choose the pick list in the upper-right corner, then select All.
. Choose the Security icon.
. Choose the Password box.
. Assign a password and a password hint to your Treo.
. Choose the Auto Lock Handheld box.
When prompted, enter your password.
. Choose one of the following options:

0O 0~ WND =

* Never: Prevents your Treo from locking automatically.

* On power off: Locks your Treo when you turn off the screen, or when
it shuts off with the auto-off feature.
At a preset time: Locks your Treo at a specific time of day.
After a preset delay: Locks your Treo after a period of inactivity.

Lock Handheld

Autornatically lock handheld:

On power off
At apraset timne
RAfter a preset dela

“tour handheld will not lock
Current Privacy: autornatically.

w Show Records

Lock: & Turn OFf... Help

o
¢

Important: If you lock your
system, you must enter the
exact password to unlock
it. If you forget the
password, you need to
perform a hard reset to
resume using your phone.
Performing a hard reset
deletes all the records in
your phone. However, you
can restore all previously
synchronized data at the
next HotSync operation
(see page 137).

To lock your system
manually, choose Lock &
Turn Off, and then choose
0ff & Lock.
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Setting Owner Preferences
You can use Owner Preferences to record information that you want to
associate with your Treo, such as your name, company name, and phone
number. If you lock your keyboard, the Owner Preferences information appears
on the screen that requests your password to unlock it, and you must also
enter your password to change the Owner Preferences information.

. Press Applications Launcher@.

. Choose the pick list in the upper-right corner, then select All.

. Choose the Prefs icon.

. Choose the pick list in the upper-right corner, then select Owner.

. If you assigned a password with the Security application, choose Unlock,

enter your password, then choose OK to continue.

6. Type the text that you want to appear in the Owner Preferences screen.

.Preferences - Cner

[This device is owned bay:

ukari Haitani
{2 Carol Avenue
ey York, MY 10001
E12-555-5754
haitani@rail.corr]

Locking your phone and data

Private records

In most applications you can mark individual entries as private. All private
entries remain visible and accessible until you select the Security setting to
hide or mask them. When you hide entries, they do not appear anywhere in
the application. When you mask entries, a visual placeholder appears where
the entry would normally appear. If you define a password, you must enter it
to display private entries. If you do not define a password, you (or anyone
else) can reveal private entries without a password.

1. Display the entry that you want to mark private.

2. Choose Details.

3. Check the Private box.

4. Choose OK.

Hiding or masking all private records

. Make sure the records you want to mask are marked private.

. Press Applications Launcher @.

. Choose the pick list in the upper-right corner, then select All.

. Choose the Security icon.

. Choose the Current Privacy pick list, then select either Hide Records or
Mask Records.

Viewing all private records

. Make sure the records you want to mask are marked private.

. Press Applications Launcher @ .

. Choose the pick list in the upper-right corner, then select All.

. Choose the Security icon.

. Choose the Current Privacy pick list, then select Show Records.

. If the Show Private Records dialog appears, enter your password, then
choose OK.

o
4

As a security measure,
masked Contacts records are
temporarily hidden when you
perform a search. So you will
not see a placeholder for
masked entries when viewing
the results of a Lookup or
Find request.
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Viewing private entries in a specific application

1. Launch the application that contains the private entries you want to display.
2. Press Menu (meny) .

3. From the Options menu, choose Security (/H).

4. Choose the Current Privacy pick list, then select Show Records.

5. Choose OK.

Security and Palm Desktop (Windows)

Palm Desktop for Windows observes the security password for your Treo. If
you forget your Treo password, you cannot view your data in Palm Desktop.
You can change your password, but all records marked as Private will be
deleted. You can restore these records at the next HotSync operation.

. Press Applications Launcher@.

. Choose the pick list in the upper-right corner, then select All.

. Choose the Security icon.

. Choose the Password box.

. Choose the Lost Password box.

. Choose Yes.

If you want additional security for Palm Desktop files, you may wish to
purchase a third-party solution.

Locking your phone and data

it something happens:

help

if something happens: help
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Always use the same
language for your Treo and
your desktop software.
Otherwise, you may lose
data.

Upgrading from another Palm
Powered device

To transfer all compatible applications and data from your previous device to

your new Treo:

1. Perform a HotSync operation with your old device and your old desktop
software to back up your data one last time.

2. Install the Palm Desktop synchronization software from the CD that
came with your Treo (see page 29). During the installation process,
perform a HotSync operation with your new Treo. When prompted to
choose a user name for your new Treo, be sure to select the existing
user name for your old device.

. Some third-party applications may be quarantined by the HotSync Manager
because they are not compatible with the Palm OS 5.2 on your Treo. Do not
manually install any quarantined files (see the documentation that came with
the third-party applications for more information).

. If you plan to continue using your old device, perform a hard reset (see
page 132) to remove its associated user name. Each device you
synchronize with your computer must have a unique name. The next time
you synchronize with your old device, be sure to assign it a new user name.

After upgrading, there are a few things you need to know about your new Treo:

» Address Book: This application is now called Contacts. To launch
Contacts, press Phone &), then use the 5-way navigation control to
choose Contacts.

» Date Book+: This application is now called Calendar. To access this
application, press Calendar @ .
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Applications Launcher: Some previous Palm Powered devices called this
the Home screen. To access this screen, press Applications Launcher @ .
Find: Some previous Palm Powered devices launched this global search
engine by tapping the magnifying glass icon in the Graffiti area. Now you
can access it by pressing Option (7) and Shift together.

Menu commands: Users familiar with Graffit's Menu launch command
can now access system menus by pressing Menu (see page 22).
Backlight: Treo includes a keyboard backlight that also dims the screen
slightly for low light conditions. While your Treo screen is on, press
Option () then P to turn on the keyboard backlight.

Center button: If you used a previous Treo phone, you might be

accustomed to pressing Spacebar to activate commands or dial numbers.

With this Treo phone, we recommend pressing Center instead.

Screen button: The fourth button on the right is used to control the
screen and is not an application button. However, you can remap this
button to your favorite application if you wish (see page 117).

Internet connection: This Treo was designed to work on GPRS wireless
data networks. When you sign up for a GPRS wireless data account,
these settings are automatically configured on your Treo. If you prefer to
use an older, manual dial-up connection method, enter your Internet
service provider's settings in Network Preferences.

5-way navigation compatibility: Some Palm OS 5 applications are optimized
for b-way navigation on devices other than Treo. Therefore you may notice
inconsistencies with software that is not designed with Treo in mind.

To access a menu shorteut,
press Menu, then the letter
for the shortout.

Some third-party utilities
allow you to backup your
old device's data onto an
SD or MMC card, and then
transfer the data to your
Treo. We do not recommend
this method because any
incompatible applications
are also transferred to your
Treo.
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Trouble installing Palm
Desktop?

The CD included with your Treo installs the software and drivers that let you
synchronize with Palm Desktop software or Microsoft Outlook for Windows.
If you want to synchronize with a different Personal Information Manager
(PIM), you must install a third-party solution. Contact the PIM's author or
vendor to learn if software is available for your Treo.

1. Restart your computer.

2. Quit any active applications, including virus scanners and Internet security
applications.

3. Make sure you're installing the version of Palm Desktop that came on
the CD with your Treo. Other versions of Palm Desktop may not work
with this Treo.

. Make sure your computer profile includes administrator rights to install
software. In large organizations, these are usually granted by the system
administrator.

. Trouble installing Palm Desktop?

Resetting your Treo

Soft reset

A soft reset is similar to restarting a computer. If your Treo is not responding
or you have trouble synchronizing with your computer, a soft reset may help.
Unless your battery is extremely low, a soft reset should not affect your data.
1. Unscrew the stylus tip to access the reset tool.

2. Use the reset tool to gently press the reset button on the back of your Treo.

System reset

A system reset, also called a safe or warm reset, tells your Treo to stop what

it's doing and start over again without loading any system extras. If your Treo

loops or freezes during a soft reset, a system reset may help. Performing a

system reset allows you to get out of an endless loop in order to uninstall a

third-party application causing the looping. Unless your battery is extremely

low, a system reset should not affect your data.

1. Unscrew the stylus tip to access the reset tool.

2. While holding Up 4, use the reset tool to gently press the reset button
on the back of your Treo.

3. When the Palm Powered logo appears, release Up

If you need to perform a
system reset and disable
conflicting applications,
always end the process with
a soft reset. This retums
your Treo to normal
operation.
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Hard reset Screen

A hard reset erases all data and third-party software on your Treo. Never
perform a hard reset without first trying a soft and system reset. You can
restore previously synchronized data with the next HotSync operation.

A hard reset can tell you whether a problem stems from your Treo or an
application installed on it. If you do not experience the problem after you 1. Look closely at the screen. If you can see a dim image, try adjusting the
perform a hard reset, the problem may be related to software you installed. screen contrast and brightness (see page 114).

See page 145 for suggestions on diagnosing third-party software issues. . If that doesn't work, perform a soft reset (see page 131).
1. Unscrew the stylus tip to access the reset tool. . If that doesn’t work, connect the Treo to the AC charger (see page 12)
2. While holding the Wireless Mode button (), use the reset tool to gently and perform a soft reset again.
press the reset button on the back of your Treo. . If that doesn’t work, perform a hard reset (see page 132)
. When the Palm Powered logo appears, release the Wireless Mode
button (). The screen doesn't respond accurately to taps or activates
. When the warning appears, press Up to confirm the hard reset. wrong features
. If a language selection screen appears, select the same language you . Press Applications Launcher @.
selected for your desktop software. . Choose the pick list in the upper-right corner, then select All.
. Choose the Prefs icon.
. Choose the pick list in the upper-right corner, then select Display.
. Choose Touchscreen.
. Follow the onscreen instructions to recalibrate the touchscreen.

The screen appears blank
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Become familiar with low
coverage areas where you
live, commute, work, and
play. Then, you will know
when to expect signal
strength issues.

Network connection

Signal strength is weak

1. If standing, move about 10 feet in any direction.

2. In a building, move near a window. Open any metal blinds.

3. In a building, move outdoors or to a more open area.

4. Outdoors, move away from large buildings, trees, or electrical wires.
5. In a vehicle, move your Treo level with a window.

Treo won't connect to the mobile network

1. Try our suggestions above for weak signals.

2. Turn off Wireless Mode and turn it on again (see page 14).
3. Remove the SIM card and re-insert it (see page 13).

4. Perform a soft reset (see page 131).

Treo hangs up when | hold it to my ear

You may be accidentally pressing the onscreen Hang Up button with your
cheek. Try holding the phone so your face doesn't press against the screen.
If this is not convenient, you may want to disable the touchscreen during
active calls (see page 122).

Treo makes or answers calls when it's in a briefcase or pocket
ltems in your briefcase or pocket may be pressing the onscreen Answer
button, or otherwise activating screen items. If this happens, you may want
to disable the touchscreen during incoming calls (see page 121).

134 :: Network connection

| can't tell if data services are available

The following icons indicate data services:

Tr Wireless Mode is on and a GPRS network is within range.

T Wireless Mode is on but you are not connected to any GPRS
network.

You are connected to a GPRS network and a data session is
F active (for example, when you are browsing the web). You can
still receive calls.

Tj—'ﬂ You are actively using a dial-up (CSD) connection.

Wireless Mode seems to turn off by itself

If a system error and reset occurs, Treo automatically turns on Wireless
Mode if it was on before the reset. However, if the Treo can’'t determine
whether Wireless Mode was on before the reset, it does not turn on
automatically (see page 14).

Treo won't connect to the Internet

Your Treo supports GPRS. To connect to the Internet, you must subscribe to
and activate GPRS data services with your mobile service provider.
+ Press and hold the Wireless Mode button (') to turn off Wireless Mode.
Then, press and hold the same button to turn it back on again.
Perform a soft reset (see page 131).
For additional suggestions, see www.handspring.com/support.

Network connection
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Network connection

Contact your mobile service provider to verify that your subscription plan
includes high-speed data services and that these services have been
correctly activated. Your mobile service provider should also be able to
tell you if there are any outages in your location. Confirm your user name
and password.

Confirm that high-speed data services are correctly configured on your Treo:

. Press Applications Launcher@.

. Choose the pick list in the upper-right corner, then select All.

. Choose the Prefs icon.

. Choose the pick list in the upper-right corner, then select Network.

. If the Service field says Untitled, choose the Service pick list, then
select the appropriate data service. Call your mobile service provider
for more information about their data services

. Choose Modify and enter the user name and password you received
from your mobile service provider.

7. Choose OK.

| can't send or receive text or multimedia messages

Make sure the SIM card is inserted correctly (see page 13) and Wireless
Mode is turned on (see page 14).

Contact your mobile service provider to verify that your plan includes
messaging services, that these services have been correctly activated,
and that they are available at your location (your mobile service provider
should be able to tell you if messaging services have been experiencing
transmission delays).

If possible, contact the recipient or sender of the message, and make
sure the receiving device can handle the type of file that is being sent.

Synchronization (HotSync)

Synchronization lets you back up your Treo data onto your computer. If you
ever need to perform a hard reset or otherwise erase all your data on your
Treo, you can perform a HotSync operation to restore the data. To make sure
you always have an up-to-date backup of your data, synchronize frequently.

Before you attempt a HotSync operation, make sure you have installed
the Palm Desktop and HotSync Manager software from the CD that came
with your Treo.

Desktop does not respond to HotSync attempt
As you complete the following steps, perform a HotSync operation after
each. If the synchronization is successful, you do not need to complete the
remaining steps.
1. Verify that the HotSync cable is securely connected at all points (see
page 28).
. Make sure that the HotSync Manager is running:

* Windows: Click the HotSync Manager icon @) in the lower-right
corner and make sure Local USB is checked. If you don't see the
HotSync Manager icon, click Start, select Programs, select Handspring
and then select HotSync Manager.

2 | Q. | e mMBAOD 1zz7em

* Macintosh: Find the Palm folder on your Mac hard drive. Double-click
the HotSync Manager icon ) in the Palm folder. In the Connection
Settings panel, set the Local Setup Port to Handspring USB.

Every device needs a
unique name. Never
synchronize more than one
device to the same user
name on your computer.

If you're using an optional
serial HotSync cable, click
the HotSync Manager icon
on your computer and make
sure Local Serial is
checked.
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. Verify with your computer hardware vendor that your operating system
supports your internal USB Controller.

. Perform a soft reset (see page 131).

. If problems persist and you're synchronizing through a USB hub, try
connecting the HotSync cable to a different USB port, or directly to your
computer's built-in USB port.

6. Uninstall Palm Desktop.
7. Reboot your computer.
8. Reinstall Palm Desktop.

HotSync operation starts but stops without finishing

As you complete the following steps, perform a HotSync operation after
each step. If the synchronization is successful, you do not need to complete
the remaining steps.

1. If you upgraded from a previous Palm Powered device, there may be
conflicts with files from your previous device. Locate your Backup folder
(Windows: C:\Program Files\Handspring\user name; Macintosh: Mac
HD\Applications\Palm\Users\user name). Move the Backup folder to
another location. Perform a HotSync operation, and then manually
reinstall any third-party applications you want on your new phone, from
the items in the old Backup folder you moved.

. (Windows only) If the Windows New Hardware Wizard appears, the
HotSync process may be timing out before the wizard completes its job.
Follow all instructions in the New Hardware Wizard, and attempt another
HotSync operation.

. Uninstall Palm Desktop.

. Reboot your computer.

. Reinstall Palm Desktop.

Synchronization (HotSync)

HotSync operation finishes but data does not appear
where it should

1.

Make sure you're synchronizing with the intended desktop Personal
Information Manager (PIM). The CD that came with your Treo lets you
synchronize with Palm Desktop or Microsoft Outlook for Windows. If you use
a different PIM, you will need to install third-party software to synchronize.
Consult the company that makes the PIM for more information.

. If there are multiple Palm Powered devices synchronizing with your

computer, make sure you are synchronizing with the correct user name.
If data is not appearing in Palm Desktop, make sure the correct user
name is selected in the toolbar of Palm Desktop.

. Launch the HotSync Manager application on your computer, and make

sure the necessary conduits are set to Synchronize the files.

. Uninstall Palm Desktop.

. Reboot your computer.

. Reinstall Palm Desktop.

. (Outlook only) With the included software, your Treo can synchronize with

the root folders of Contacts, Calendar, Tasks, and Notes. If you want to
synchronize with a global Exchange Address Book, you must copy the
addresses to your local Contacts list in Outlook (right-click the
addresses, and select Add to Personal Address Book).

. (Outlook only) Outlook subfolders and public folders are not accessible with

the included software. You may wish to use a third-party solution instead.

. (Outlook only) If you're trying to synchronize offline, be sure to set your

Outlook Calendar, Contacts, Notes, and Tasks to be available offline.

The software that lets you
synchronize with Microsoft
Outlook is called
PocketMirror, from Chapura,
Inc. When you install the
Treo software from the CD,
PocketMirror will be
activated if you choose the
option to synchronize with
Qutlook.
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If you use web-based email
(Hotmail, AOL) or corporate
email (Microsoft Outlook,
Lotus Notes), the Mail
application that comes with
Treo will not work. You must
use a third-party solution.

Contact your email service

provider if you are not sure
whether your email account
is POP3-compatible.

Mail

| can't receive email

First, make sure you have Internet access: launch the Blazer web browser to
see if you can view a web page you've successfully viewed before. If
necessary, ensure that you are viewing the page directly from the Internet:
press Menu , then from the Page menu, choose Refresh. The email
account you use with the Mail application must be POP3-compatible, such
as Earthlink.

. In Mail, press Menu (fmeny) .

. From the View menu, choose Edit Accounts.

. Highlight an account, then choose Edit.

. Make sure your email address and password are correct.

. Choose the Server tab.

. Check the Incoming (POP3) Server and Outgoing (SMTP) Server
settings for your email account. If you do not have this information,
please contact your email service provider.

7. Choose OK to accept these settings.
8. Choose Done.

Other things to consider when trying to retrieve email:
* In Mail, press Menu , then from the Options menu, choose
Connection Log. This log contains details and error messages from the

Some email preferences may not work with your Treo or your mobile
network’s capabilities. To view these settings, press Menu , then
from the View menu, choose Edit Accounts. Choose an account and
press Right > to choose Edit. Each setting is explained in detail in the
Tips for that tab. Contact your email service provider to determine the
correct settings for your email account.

Auto-retrieve settings apply to only the mail account you are currently
viewing. If you have two accounts, Treo auto-retrieves emails for only the
current account. To change the current account, press Menu , then
from the View menu, choose another account.

| can't open or save an attachment

You can only open attachments that are supported by the built-in
software on your Treo, or by third-party applications that can open the
attachment type. If you can't open an attachment on your Treo, the
attachment appears with the paperclip icon .

Large attachments may be truncated, which prevents you from saving

them. Scroll to the bottom of the email message to see if this is the case.

To retrieve the rest of the attachment, press Menu , then from the
Message menu, choose Get Entire Message. This downloads the
remainder of the attachment so that you can save it.

| can't send email

Your ability to send email depends on several factors. You may need to enter

When retrieving messages,
you may see a larger
number of messages than
you actually receive (e.g.
you see Retrieving 1 of 10
messages and you only
receive 3 messages). If this
happens, check your
Delivery Preferences. If the
preferences are set to
retrieve only recent emails,
any older emails may
appear in the total number,
but are not delivered to
your Treo.

additional information into the Mail application. Also, some mobile service
providers use Internet security requirements that may cause difficulties with
your email service.

last several send and receive sessions.

Mail does not automatically retrieve your email when:

* Your radio is off.

* You are outside the automatic delivery time window. See page 79 for
more information on customizing your mail settings.




First, obtain this information from your mobile service provider*:
» Does the Internet connection they provide support sending SMTP emails?
* |s there an alternate SMTP authenticated server used for email?

* s SSL required for POP3 or SMTP email transactions?
* If you are using a circuit-switched data (CSD) connection, contact your Internet
service provider for this information, instead of your mobile service provider.

Then, contact your email service provider for this information:

» Does this provider support the POP3 protocol? If they don't, you won't be
able to use Mail for this email account.
Does this provider allow email access from mobile phone networks?
What is the User Name for your email account?
What is the Outgoing (SMTP) server for your email account? Does it
require authentication? Does it require SSL? Does it use the same User
Name for POP3 and SMTP?

Then, follow these steps:
In Mail, press Menu .
From the View menu, choose Edit Accounts.
Highlight the account you want to edit, then choose Edit.
Make sure your email address and password are correct.
Choose the Server tab. Tap the Information icon [I] for a detailed
explanation of Server settings.
Enter the correct Incoming (POP3) Server setting for your email account.
Enter the SMTP server used by your mobile service provider for email.
Choose the Advanced tab. Tap the Information icon [E] for a detailed
explanation of Advanced settings.
Check or uncheck the boxes for SSL required for POP3 and SSL
required for SMTP, according to the information you received.
If necessary, enter your User Name. Also enter your email password in
the box.

10. Choose OK to accept these settings.

11. Choose Done.

Web

| can't access a page

First, make sure you have Internet access: launch Blazer and try to view a web
page you've loaded before. Press Menu , then from the Page menu,
choose Refresh to get the latest version from the Internet. After confirming
your Internet connection, try to view the page in question again, and press
Menu , then from the Page menu, choose Refresh.

If you're still having trouble, the page may contain elements that are not
supported by Blazer. These include Flash, Shockwave, VBScript, WML script,
and other plugins.

Some websites use a redirector to their true home page (for example, if
you enter the address http://www.handspring.com/support it may resolve
to http://support.handspring.com/esupport/html/startjsp). If Blazer can't
follow the redirect, try using a desktop browser to see the landing page of
the redirector, and enter that address in Blazer.

An image or map displays too small on the Treo screen

Blazer has two modes: Optimized and Wide Page. Optimized Mode re-sizes
all images and page elements to fit in a single column on the Treo screen.
Switch to Wide Page mode to see the full-size image (see page 54).

A secure site refuses to permit a transaction

Some websites don't support certain browsers for transactions. Please contact
the site’s webmaster to make sure the site allows transactions using Blazer.

Treo can launch your email
application when you
choose an email address on
a web page. If nothing
happens when you choose
the link, try setting up your
email application first.




Camera

The Camera application takes pictures at Small picture size (160x120
pixels) and Large picture size (640x480 pixels, or .3 megapixel). Here are
some tips for taking good pictures with the built-in camera:
* Clean the camera’s lens with a soft, lint-free cloth.
« Take pictures in bright lighting conditions. Low-light images may be
grainy, due to the sensitivity of the camera.
Hold the camera as still as possible. You may want to support your picture-
taking arm up against your body or a stationary object (such as a wall).
Keep the subject of the pictures still. Exposure time is longer with lower
light levels, so you may see a blur.
For best results, verify that you have the brightest light source coming
from behind you, lighting the subject’s face. Don't take indoor pictures
with the subject in front of a window or light.
Make sure the subject is at least 18 inches away from the camera to
ensure good focus.

Remember, when you synchronize, your Camera images are stored in the
Treo Pictures folder on your hard drive (see page 62).

Third-party applications

On rare occasions, third-party applications can cause conflicts on your Treo.
Third-party applications that modify wireless features may require extra
troubleshooting.

If you recently installed an application and your Treo seems to be stuck,
try the following:

. Perform a soft reset (see page 131).

. If the problem persists, perform a system reset (see page 131).

. Delete the most recently installed application from your Treo (see page 103).

. If the problem persists, perform another system reset.

. Delete other third-party applications one at a time until you eliminate
the problem.

. If none of the steps above are possible, you may wish to perform a hard
reset (see page 132). Then, locate your Backup folder on your computer
(Windows: C:\Program Files\Handspring\user name; Macintosh: Mac
HD\Applications\Palm\Users\user name). If you find a .prc or .pdb file for
any applications you just removed, delete the file(s) from the Backup folder.
Then, perform a HotSync operation to restore your data and applications.

Remember, not all third-party applications were written with the Treo keyboard
and 5-way navigation in mind. You may encounter strange behavior or errors
in these applications if you use the keyboard and navigation control.

Getting more help

Contact the author or vendor of any third-party software if you require
further assistance.

Third-party applications
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Errors

Your Treo is designed to minimize interruptions, when a system error occurs.
If Treo encounters a system error, it automatically resets itself and resumes
functioning as normal. If possible, it even turns Wireless Mode back on if it
was on before the error occurred.
Sometimes, you might want to know more about an error. Treo uses a
special interface to show error messages in greater detail.
1. Press Phone ®).
2. Press Center, then choose Dial Pad.
3. Type # * 377, then press Center.
4. Review the screen with details about the conditions that lead up to the
most recent automatic reset.
. Choose OK.

Please note that third-party developers create their own error messages. If
you do not understand an error message, please contact the developer of
the application for help.

Making room on your Treo

If you store a large number of records, or install many third-party
applications, the internal memory on your Treo may fill up. Here are some
common ways to clear space on your Treo:

* Mail: Emails that have large attachments can quickly consume memory
on your Treo. Delete emails with large attachments. If you have hundreds
of messages with or without attachments, you may wish to delete older
messages to make room (see page 78).

Camera: Large size images take up a lot of memory. Move images to an
expansion card or delete images from your Treo (see page 62).

MMS: Multimedia content also can consume excessive memory. Move
MMS content to an expansion card or delete large files from your Treo
(see page 71).

Internet: If you have set a large Blazer cache, you may wish to use
Blazer's advanced Memory Management settings to clear all recent
pages (see page 59).

Third-party applications: You can delete infrequently used applications or
move them to an expansion card (see page 103).

Also, remember that your Treo includes an expansion slot, and that you can
store applications and data on expansion cards. However, you still need some
free memory on the Treo itself to run applications from an expansion card.

Making room on your Treo
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Glossary

ALS (Alternate Line Service): A service that
enables two phone numbers to coexist on one
phone/SIM. The Treo phone supports ALS, but be
sure to contact your mobile service provider for
regional availability of this service.

Alt (alternative) : A keyboard key. Type a letter on
the keyboard, then press Alt to access variations
such as international characters and symbols.

Applications Launcher @) : The view on your Treo
from which you can launch all applications.

Auto-off interval: The time of inactivity that passes
before the screen on your Treo turns off. Wireless Mode

is unaffected by this setting.

Beam: The process of sending or receiving a data

record or application using the infrared port on your Treo.

CSD (Circuit-Switched Data): A dial-up Internet
connection. You pay for the connection time, not how
much data you transfer. Contrast with GPRS.

GPRS (General Packet Radio Service): The next
generation of mobile Internet connectivity that allows
persistent data connections. You pay for the amount of
data you transfer, not the connection time.

148 : Glossary

HotSync: The PalmSource technology that
synchronizes your Treo and your computer with the
simple press of a button.

HotSync Manager: The computer application that
manages the synchronization with your Treo.

Infrared (IR): A way of transmitting data using light
waves. The IR port on your Treo lets you transfer data
between other IR devices within a short radius.

Install tool: The component of Palm Desktop software
that enables you to install Palm OS applications and
data on your Treo.

Lithium lon (Li-lon): The rechargeable battery
technology used in Treo phones.

MMS (Multimedia Messaging System): An enhanced
form of SMS messaging that lets you send pictures,
animations, and ring tones almost instantly.

Option key O: The keyboard button that lets you
access the alternative feature that appears above the
letter on each key.

Palm Desktop: A PIM application for computers that
helps you manage your personal information and keep
your personal data synchronized with your Treo.

Palm OS: The operating system of your Treo phone. A
trademark of PalmSource, Palm OS is known for its
simplicity of use and for the large number of
applications that can be added to your Treo.

Phone @ : The application on your Treo that provides
quick access to the most commonly used applications
on your Treo.

PIM (Personal Information Management): A genre
of software that includes applications such as Palm
Desktop software, Microsoft Outlook, Lotus Notes, and
ACTL PIMs generally store contacts, schedules, to do
items, and memos.

PIN (Personal Identification Number): The four-digit
password assigned to your SIM card by your mobile
service provider. Turning on the PIN lock secures your
wireless account. See also PUK.

PocketMirror: Software included on the Treo CD that
lets you synchronize with Microsoft Outlook (English
language and Windows only). PocketMirror is made by a
third-party company called Chapura, Inc.

PUK (Pin Unlock Code): A special extended
password assigned to your SIM card. If you enter the
wrong PIN more than three times, your SIM will be
blocked, and you must call your mobile service provider
for the PUK.

SIM (Subscriber Identity Module): The smartcard,
inserted in your Treo, that contains your GSM mobile
account information. SIM cards are portable between
GSM phones — your mobile subscriber information
moves to whatever phone houses the SIM.

SMS (Short Messaging Service): The service that
exchanges short text messages almost instantly
between mobile phones. These messages can usually
include up to 160 characters. Treo phones can send and
receive SMS messages while you are on a voice call.

User name: The name associated with your Treo that
distinguishes it from other Palm Powered devices. When
you first synchronize your Treo, you are asked to give it
a user name.

Wireless Mode: The feature inside your Treo that

controls the radio which enables you connect to the
mobile network for wireless communications.
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FCC Statement This device complies with part 15 of the FCC
rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may
cause undesired operation.

This device has been tested and found to comply with the limits
for a Class B digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

« Reorient or relocate the receiving antenna

« Increase the separation between the equipment and receiver

« Connect the equipment into an outlet or circuit different from that
to which the receiver is connected

Consult the dealer or an experienced radio/TV technician for help

and for additional suggestions.

RF Safety Exposure To Radio Frequency Energy (SAR) Radio
transmitting devices radiate Radio Frequency (RF) energy during its
operation. RF energy can be absorbed into the human body and
potentially can cause adverse health effects if excessive levels are
absorbed. The unit of measurement for human exposure to RF
energy is “Specific Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industrie
Canada (IC), and other agencies around the world have established
limits that incorporate a substantial safety margin designed to
assure the safety of all persons using this equipment.

In order to certify this unit for sale in the US, Canada and Europe
this unit has been tested for RF exposure compliance at a qualified
test laboratory and found to comply with the regulations regarding
exposure to RF Energy.

SAR was measured with the unit transmitting at its maximum
certified RF power. Often, however, during normal operation the unit
will transmit much less than maximum power. Transmit power is
controlled automatically and, in general is reduced as you get closer
to a cellular base station. This reduction in transmit power will result
in a lower RF energy exposure and resulting SAR value.

FCC RF Safety Statement In order to comply with FCC RF
exposure safety guidelines, users MUST use one of the following
types of body-worn accessories.

1. A Handspring brand body-worn accessory that has been tested
for SAR compliance and is intended for use with this product.

2. An accessory that contains NO metal (snaps, clips, etc) and provides
AT LEAST 1 cm of separation between the users body and the unit.
Do NOT use the device in a manner such that it is in direct contact

with the body (ie. on the lap or in a breast pocket). Such use will likely

exceed FCC RF safety exposure limits See www.fcc.gov/oet/rfsafety/
for more information on RF exposure safety.

Responsible party
(North America)
Handspring, Inc.

(Europe)
John Hartnett

189 Bernardo Avenue
Mountain View, CA 94043
United States of America

VP Worldwide Operations
Handspring
89 rue de Lyon

www.handspring.com 1203 Geneva, Switzerland
Antenna Care/Unauthorized Modifications Use only the supplied
integral antenna. Unauthorized antenna modifications or attachments
could damage the unit and may violate FCC regulations. Any changes
or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

Declaration of Conformity

Treo Model 600 Handspring declares that the above models of Treo
communicators are compliant with the regulations below. The declaration
applies to the communicators and their associated accessories (power
supply, headset, USB and serial cable) where applicable.

Maximum Measured SAR Values (W/kg)
Band: 8560 MHz 900 MHz 1800 MHz 1900 MHz

Head SAR: 1.49 1.07 1.63 1.05

Body SAR: 646 .703 402 .336

EMC: EN 301 489

GSM: EN 301 419-1(Apr 2000)

EN 310 420 (Dec 1999)

SAR: ANSI/IEEE C95.1 1992

EN 50360 (July 2001)

EN 50361 (July 2001)

FCC OET Bulletin 65 Supplement C
Safety: EN 60950: 2000 (Jan-2000)
Radiated Emissions: EN 556022
Immunity: EN 556024
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Info 104, 107,117

installing 27, 29, 77, 100-102,
128, 130, 131, 132, 139,
145, 147,148

Launcher 22, 26, 98, 100-104,
106-107, 116, 129, 148

Mail 26, 73-80, 110-111,
140-142, 147

Memo Pad 90

MMS 5, 13,69-72, 110-111,
147, 1490pening 25-26, 49,
51,65, 106

Phone 10, 15, 16, 25, 26,
34-51,95,97 110-112,
121-123, 149

Preferences 36, 45-46, 54, 57,
58-59, 62, 67-68, 72, 76,
79-80, 84-86, 89,
110-126, 129, 141

removing 103, 145

security 53, 76, 121-126, 130,
141

SMS 38, 49, 64-68, 111, 120,
149

third-party 18, 73, 77, 96,
100-103, 126, 128, 129,
130, 131, 132, 138, 139,
140, 141, 145, 146, 147,
149

To Do List 86-89, 120

Appointments. See Calendar
Archive files

for deleted applications 103

saving completed To Do items
87

Auto-off setting 31, 120, 123, 140

B

Backlight, keyboard 12, 14, 22, 31,
114,129
Backup. See HotSync
Battery
charging 12, 15, 31
conserving power 12, 14, 31,
120
gauge 12, 35
low 31, 131
type 148
usage 35

Beaming
applications 98, 120, 148
business card 48, 97
information 97-98, 120, 148
location of IR port 9, 97
problems with 120
See also Infrared
Beep tone 14, 15, 106, 110-111,
113,120
Birthdays. See Repeating events
Blazer
bookmarks 54-56
opening 26, 53
overview 53
installing applications from 100
Preferences 58-59
problems with 143, 147
viewing web pages 53-54,
57-58
Boilerplates. See Templates
Bold font for text 115
Bookmarks 54-56
Brightness Control 31, 114, 133
Business card for beaming 48, 97
Buttons
b-way navigation 10, 15,
18-21, 26, 36-40, 42-44,
47-48,50-51, 82,95, 121,
128,129, 145
application 10, 26-26, 49, 51,
73,80, 117,129
Calendar 10, 25-26, 82-86,
117,128
HotSync 28, 30, 117
Messaging 10, 25-26, 64-68,
73,117
Phone 10, 15, 16, 2626,
34-51,60, 95, 112, 122,
128, 146
preferences 117
ringer switch 9, 39, 97, 113,
120
Screen 10, 14, 25-26, 121,
129
volume 10, 16,39, 110, 111,
113
Wireless Mode 9, 14, 15, 122,
132,135

C
Cable
charger 12
connecting to computer 28
HotSync 9, 27-28, 30, 117,
137,138
Calculator 23, 26, 93-94
Calendar
adding events 82-84
alarm 83, 110-111, 113,120
button 10, 26-26, 82-86,
117,128
changing events 83
conflicting events 85
deleting events 83
display format 82, 84-86
floating events 85
fonts 115
opening 25-26, 128
Preferences 84-86
repeating events 84
scheduling events 82-84
selecting date 82
start of week 119
switching views 82
synchronizing 82, 139
To Do List items 86
untimed events 82, 83
using during call 42
Calibration 15, 115, 133
Call
b-way conference 44
5-way navigation 42, 121
active 42-44, 121
answering 39, 44, 52
barring 46
conference 44
data 35, 136
dialing 15, 23, 36-38, 71
emergency 121
ending 15, 42, 52
forwarding 31, 35, 46-46
hanging up 15, 42, 52
history log 38
ignoring 39, 44
incoming 14, 39, 44, 120, 135
missed 35, 41
muting 42




outgoing 14, 15, 36-38, 71
placing a second 42, 43
placing on hold 42
Preferences 45-46, 110
preventing 39, 46, 121, 134
receiving 14, 39, 44, 120, 135
redialing 38
ringer 39, 113
sending to voicemail 39, 44
status 35
switching 43, 52
using applications during 39,
42, 43, 67,149
using speakerphone 42
using touchscreen during 121
voicemail 41
volume 16, 42, 111
waiting 44, 52
Caller ID 39, 50, 60, 110, 112
Capital letters 23
Card
Business 48, 97
expansion 62, 97,98, 101, 103,
105-108, 147
MMC 105, 129
SD 62, 105, 129
SIM 8,13, 16, 36, 68, 121,
122-123, 134, 136, 149
Categories
application 26, 116
assigning records to 47, 60, 62,
87-88, 90
beaming 97, 98
creating 116
default 62, 98
displaying 86, 89, 116
expansion card 106
Charger. See AC charger
Charging battery 12, 15, 31, 36
CityTime 26, 91-92
Color control 68, 115, 120
COM port. See Ports
Command buttons 16-16
Command equivalents (keyboard)
21,561,129
Communicator. See Phone
Conduits 30, 139
See also HotSync
Conference calls 44
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Conflicting events 85
Connection
AC charger 12
computer 28, 138
headset 52
HotSync cable 28, 138
Internet 53-569, 129, 135-136,
142,143, 148
log 140
MMS 72
mobile network 14, 35, 40, 46,
134-135, 149
Connection preferences 137
Contacts
adding 47
addressing messages to 47, 64,
70, 74
attaching to email 75
deleting
dialing 36
entering 47
fonts 115
importing from SIM 36, 48
looking up 95-96
notes 47
opening 128
private 125
receiving calls from 110
synchronizing 27, 30, 139
viewing 36, 47, 48
Continuous events. See Repeating
events
Copying
addresses to Microsoft Outlook
139
applications 107
blind 75, 80
carbon 75
phone number 37, 57
pictures 60, 62
text 57
Country default setting 91, 119
See also Language selection
Coverage area 8, 15, 31, 35, 46,
65, 66, 110, 134-136
Cradle. See Cable
Creating
bookmarks 54-55
categories 116

Contacts entries 47
currency symbols 23-24, 64,
148

events 82-84

Favorites 49-51

memos 90

messages 64, 69-70, 74-75

notes for records 47, 87-88

To Do List items 87

wallpaper 112
Current date and time 118
Customer service 32
Customizing

Applications Launcher 116

browser settings 56, 57, 58-59

buttons 25, 117

Calendar settings 84-86

camera settings 62-63

colors 68, 115, 120

date and time formats 119

default applications 117

Mail settings 79-80, 140-141

MMS settings 72

Phone settings 36, 46-46,

110-112

security settings 121-126

SMS settings 67-68

sounds 110-111, 120

To Do List settings 86, 89

Wallpaper 112

See also Preferences
Cycling through views 26, 82, 116

D
Data

entry. See Entering data
transfer. See HotSync

Dates

deleting messages by 66, 71,
78

selecting in Calendar 82, 84

setting current 118

setting for email delivery 79

setting format 119

setting in To Do List 87-88,
89

sorting by 66, 71, 77

viewing in text messages 68

Decimal point 23, 94, 119
Default
applications 63, 117
browser mode 53, 54
button settings 117
Calendar settings 84-86, 111
camera settings 62
categories 62
Mail settings 76, 79-80
Option Lock on keyboard 23
PIN code 122
wallpaper 112
See also Preferences
Deleting
applications 103, 131, 145,
147
bookmarks 56
contacts 48
data 123, 126, 128
Desktop software 138, 139
events 83
Favorites entries 51
memos 90
messages 66, 67, 70, 71, 72,
78, 80, 147
passwords 122, 126
pictures 62, 63, 147
search entry 36
sounds 111
To Do items 87, 88
See also Purging
Desktop software
backup settings 63, 103
entering data in 47, 82
installing 29, 130
installing applications from
101-102, 148
language selection 132
password 126
removing 138, 139
security settings 126
synchronizing with 30, 47, 82,
137-139
system requirements 27
upgrading 103, 128
viewing data 63
Dial Pad 23, 37, 41, 42, 43, 49,
57,112, 146
Dialing

emergency numbers 121

Extra Digits 42, 50

from Call Log 38

from Contacts list 36, 95-96

from text message 38, 65

from web page 38, 57

last number 38

passwords 42

previous numbers 38

second call 43

voicemail 41

with Dial Pad 37, 112

with Favorites 37, 49

with keyboard 15, 36, 129
Digitizer. See Touchscreen
Display

aligning 115, 133

colors 115, 120

contrast (brightness) control

114

turning on/off 14

wallpaper 112
Docking station. See Cable
Double-booked events 85
Dragging

files in desktop software 101

using the stylus 19, 20, 55, 56

E
Editing
bookmarks 56
call forwarding number 456-46
categories 116
cities 92
contacts 48
date formats 119
events 83
Favorites 51, 112
Mail accounts 140-142
number formats 119
picture name 60, 62
QuickText 64
text 19
text messages 66
Email messages. see Mail
Emergency numbers 121
Entering data
importing from SIM 36

using phone keyboard 22-24
using the computer keyboard
47,82
Entries. See Entering data
Events. See Calendar
Exchanging data. See HotSync
Exclamation marks 23, 24, 89
Expansion cards 62, 97, 98, 101,
103, 1056-108, 147

F

Favorites
caller ID picture 50, 112
caller tone 50, 110
defining 49-51
deleting 51
dialing with 37, 43
editing 51
Extra Digits 42, 50
organizing 51
voicemail 40-41
Files
attachments 75, 77, 80, 136,
141,147
deleting from backup folder
103, 145
downloading from web 57
installing 100-102, 128
pictures 63, 69, 147
quarantined 128
ring tones 69
sounds 69, 77, 105
storing on expansion cards
105, 107
synchronizing 30, 47, 82,
137-139
Finding
applications 103
archived applications 103, 145
contacts 36, 50, 95-96, 125
messages 67, 77
private entries 125
text on web page 58
using the Find feature 22, 77,
96, 129
Floating events 85
Fonts 115
Formats preferences 119

Forwarding
calls 31, 35, 45-46
messages 71, 75, 76, 80
Frozen phone 131, 145

G

Games 31, 100, 105, 120
General preferences 31, 84, 120
Glossary 148-149

GSM 149, 150

H
Hard reset 123, 128, 132, 133,
137
Headset 9, 10, 39, 42, 52, 67,
160
Help 5, 23, 29, 32, 102, 127-147,
1560
Hiding records 87, 89, 121, 125
Hold button 42, 44
HotSync
button 28, 30, 117
cable 9, 27, 28, 30, 137, 138
conduits for synchronizing 30,
139
connector 10, 28
defined 27, 148
installing applications
101-102, 145
Manager 30, 137, 139, 149
operations 30, 31, 36, 47, 60,
82,101, 123, 126, 128,
132, 139, 144
problems with 131, 137-139
removing applications 103
setting options 139
synchronizing data 30, 31, 36,
47,60, 82, 101, 123, 126,
128,132, 139, 144

Icons
ALS 35
application 116
attachment 77, 141
battery 12, 35

Bookmarks view 54, 55
call forwarding 35
card 106
Card Info 107, 108
CityTime 91
data services 35, 135
Emoticons 64
Find 57, 129
GPRS 35
HotSync Manager 137
Information 32, 142
Lock 53, 61, 75,98, 103
Macintosh desktop software 29
magnifying glass 57, 129
Mail 74, 77
Memo Pad 90
MMS 69, 71
network status 15, 35
page 55, 56
Page view 53
Pictures view 61
Prefs 110, 114,115, 117,118,
119, 120, 122, 124, 133,
136
repeating event 84
Security 53, 123, 125, 126
signal strength 356
SMS 64, 66
Sound 71
To Do List 87
Tutorial 32
voicemail 35, 41
Ignoring calls 39,44
Importing data 36, 47, 82
Incoming calls 14, 39, 44, 120,
135
Indicators
charge 10, 12, 15, 31
LED 10, 12, 15,31
Wireless Mode 10
See also Icons
Infrared 9, 97-98, 148
Installing
applications 77, 100-102, 128,
131,132, 145, 148
conduit to install applications
30, 139
Desktop software 27, 29, 130,
139




International characters 23-24, 64,
148

IR. See Infrared

Items. See To Do List

K

Keyboard

accented characters 23-24, 148

backlight 14,22, 31,114, 129

beaming business card with 97

capital letters 23

compatibility with third-party
applications 145

computer 47, 82

dialing with 15, 36

layout 22

locking 25, 26, 121-122, 124

lowercase letters 23

menu commands 21, 129

numbers 93

online Help 23

Quick Keys 41, 49, 50, 51

shortcuts 21, 41, 49, 50, 51,
129

silencing ringer with 39

symbols 23-24, 148

L

Large font for text 115
Launching

applications 26-26, 49, 51, 106,

117,129, 143, 148

Blazer 26, 53

Calculator 26

Calendar 25-26, 82, 128

Camera 60

Contacts 47, 128

CityTime 91

Dial Pad 42

Favorites 49-51

links 65

Mail 26, 74

Memo Pad 90

MMS 69

Phone 25-26, 34

SMS 25-26, 64

To Do List 87
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Tutorial 32
see also Opening
LED 10, 12, 15,31
Letters
font 115
keyboard 22-23
Light. see LED
List
accessing command buttons
from 20
Applications Launcher 116
Calendar view 82, 119
Call Log 38, 43
Contacts 36, 139, 47-48, 64,
70, 74,77, 80, 95, 139
History 58
message 65, 66, 67, 69, 71
pick 18,19, 21
Redial 38, 43
scrolling in 18
To Do 86-89
Locking
keyboard 25, 26, 121-122,
124
phone with a password
121-124
records. See Security
Looking up. See Finding
Lost phone, contact for 124

M

Macintosh 27, 29, 102, 103, 137,
138, 145
Mail
accounts 73-74, 78, 79
attaching applications 75
attaching items 75, 80
Bec (blind copies) 75, 80
Cc (carbon copies) 75
creating messages 74-75
deleting 78, 80, 147
forwarding 76, 80
launching 26, 73, 74
messages 19, 43, 59, 61, 63,
65, 74-78, 117, 120,
140-142, 147
preferences 79-80, 110-111
receiving 76, 79

responding to 76, 80
requirements 73
saving draft messages 75
setting up 73-74
signature 80
sorting 77
troubleshooting 140-142
viewing 76, 77, 78
Maintenance information 147
Meetings. See Calendar
Memo Pad 90, 115
Memory
browser 59
Calculator 94
for expansion cards 106
regaining 87, 103, 147
required for computer 27
Memos. See Memo Pad
Menus
choosing 20-21, 54
command equivalents
(keyboard) 21, 129
Messages
accessing with Favorites 41, 51
addressing 64, 67, 72-73,
75-75
alert tones 110-111
attachments 72-73, 75, 77,
141
checking 41, 70, 76
creating 59, 64, 72-73, 74-75,
136
dialing from 38
email 73-80, 140-142
forwarding 76
photo 61, 69-72, 136, 149
preferences for 67-68, 72, 74,
79-80
purging 65, 71, 78, 147
receiving 65, 70, 76, 77,
110-111, 120, 136,
140-141
replying 67, 71, 76
selecting items in 19, 38, 65,
77,141
sorting 66, 71, 77
text 64-68, 136, 149
voicemail 41
Microphone 10, 42, 52

Microsoft
Outlook, connecting to 27, 30,
47,82, 130, 139, 140, 149
Windows 27, 60, 63, 100, 101,
103, 126, 137, 138, 145,
149
Missed calls 35,41
MMS
creating messages 69-70
deleting 71, 147
overview 69, 149
preferences 72, 110-111
purging 71
receiving 70
requirements 5, 13, 69
responding to 71
saving from 70, 71
sorting 71
templates 69
viewing 70, 71
MMS Messages. See MMS.
Modes
browser 53-54, 143
Calculator 93-94
Privacy 72
Sound 39, 113
Wireless 14, 15, 16, 31, 35, 39,
40, 46, 53, 64, 66, 76, 120,
122,123, 134-135, 146,
148, 149
Moving
Calendar events 83
cursor 18-21, 47, 53, 75, 82
files 60, 101, 138, 147
items on screen 55, 56, 78
messages 78
pictures 60, 62, 147
ringer switch 113
SIM card 122, 149
Multi-day events. See Repeating
events
Multimedia Messages. See MMS

N

Network
voicemail number 13, 41
connection 14, 15, 134-136,
149

email support 141-142

GPRS settings 129

password 41, 136

preferences 129, 136

roaming 110

service 32

signal strength 35, 134

status 15, 35, 110, 134-136

user name 136

voicemail number 13, 41

Notes

attaching to entries 47, 87-88

Lotus 140, 149

Microsoft Outlook 139

See also Memo Pad

Numbers

ALS 16, 148

Application Info 104

calculating 93-94

call forwarding 31, 456-46

entering 23, 41, 82, 93

Extra Digits 42, 50

Formats 119

dialing 15, 36-38, 43, 57, 65,
129

phone 13, 16, 19, 36-38, 47,
50, 67, 64, 65, 70, 89,
95-96, 124, 148

priority 88

speed dial 50

PIN 15, 122-123, 149

PUK 122, 149

SIM 13, 16, 68, 148, 149

Treo 16, 124, 148

version 104

0

Opening
attachments 77, 141
entries 20, 48, 51, 63,
126-126
Find dialog 96, 129
links 65
menus 20, 129
web pages 49, 51, 53, 54, 65,
140, 143
See also Launching
Options. See Preferences

Organizer 14, 31, 43, 81-98
See also Desktop software

Outgoing calls 14, 15, 36-38,
71

Outlook, connecting to 27, 30,
47,82, 130, 139, 140, 149

Overlapping events 85

Owner preferences 124

P

Palm Desktop software. See
Desktop software
Passwords
voicemail 41
Call Barring 46
changing 122
creating 123
deleting 122
email 74, 140, 142
entering 42, 50, 124, 125
forgotten 123, 126
mobile service provider's 46,
136
PIN 15, 122-123, 149
PUK 122, 149
SIM 121, 122-123
system 121, 123
voicemail 41
Pasting 37, 67
Personal information manager.
See Organizer
Phone
answering 39, 44, 52
application 34-51, 149
battery. See Battery
button 10, 15, 16, 25-26,
34-51, 60,95, 112, 122,
128, 146
Call Log 38
components 9-11
Contacts. See Contacts
contrast control 114, see also
Display
Dial Pad 23, 37, 41, 42, 43,
49,567,112, 146
dialing 15, 23, 36-38, 71, see
also Dialing
Favorites. See Favorites

hanging up 15, 42, 52
holding 134
numbers 13, 16, 19, 36-38,
47, 50, 57, 64, 65, 70, 89,
95-96, 124, 148
opening application 256-26,
34
overview 34-35
screen 10, 14, 25-26, 121,
129 see also Touchscreen
settings 110-112
signal strength 35, 134
speed dial. See Favorites
status 15, 85, 110, 134-136
turning on/off 14
Pick lists 21
PIM (personal information
manager). See Organizer
PIN 15, 122-123, 149
Ports
IR (infrared) 9, 97-98, 148
Serial 27
USB 27,28, 137, 138
Power button. See Wireless
Mode
PRC (application file extension)
100-103, 145
Preferences
Applications Launcher 116
Blazer 54, 57, 58-59
Buttons 117
Calendar 84-86
Call 45, 46
Call Barring 46
Camera 62
Date & Time 118
Display 36, 112
Formats 119
General 31, 120
HotSync button 117
icon 110, 114, 115, 117, 118,
119, 120, 122, 124, 133,
136
Keyguard 121, 122
Mail 79-80, 141
MMS 72
Network 129
Owner 124
security 76

SMS 67-68

Sound 110-111

To Do List 86, 89
Private entries 47, 88, 121,

125-126
Proxy server 59
PUK 122, 149
Punctuation marks 23-24
Purging 66, 71, 78, 87,

Q

Quick Keys 41, 49, 50, 51
QuickText 64

R

Receiving

data. See Beaming

email messages. See Mail

photo messages. See MMS

text messages. See SMS
Records. See Entering data
Redialing 38, 43
Reminder. See Alarms and alerts
Removing

applications 103, 145

Desktop software 138, 139

expansion cards 105

pictures from messages 70

SIM card 13, 134

See also Deleting
Renaming

expansion cards 108

pictures 62
Repeating events 84
Rescheduling events 83
Reset

automatic 135, 146

button 11, 131-132

hard 123, 128, 132, 133, 137,

145
soft 131, 133, 134, 138, 145,
146

system 131, 132, 145

tool 11, 131, 132

warm 131, 132, 145
Ringer 9, 39, 110, 113, 120




S
Safety 31, 160
Saving
attachments 70, 71, 141
messages 66, 69, 72, 75
pictures 60, 63, 70
sounds 71
web page 55
Scheduling events 82-84
Screen
auto-off interval 31, 120, 123,
148
blank 133
brightness 31, 114, 129
browser mode 53-54, 143
button 10, 14, 25, 26, 121, 129
calibrating 15, 115, 133
caring for 10
colors 115, 120
contrast 114
fonts 115
moving around 18-21
touching 15, 18-21, 39, 42,
93, 115,121, 122, 133, 134
wallpaper 112
Scrolling 18-19, 20, 63, 54, 57,
71,85
See also 5-way navigation
control
Searching. See Finding
Security
Desktop software 126, 130
displaying owner's name 124
email 76, 141
forgotten password 123,126
Internet 53, 130, 141
passwords 121-126
PIN 15, 122-123, 149
private records 121, 1256-126
PUK 122, 149
SIM card 121, 122-123
Sending
data 75
messages 43, 64, 67, 69-70,
74-175, 76, 80, 136, 141,
149
pictures 60, 61, 69-70, 149
sounds 69-70, 111, 149
See also Beaming
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Serial port 9, 27-28, 137
Service
ALS 35, 41, 148
customer 32
data 8, 18, 63, 73, 135-136
email 8, 73-74, 140-141, 142
GPRS 5, 8, 35, 73, 135, 148
Internet 59, 129, 135, 142
mobile service provider 15, 32
multimedia messaging 5, 8, 69,
136
SMS 64, 136
voicemail 40-41
warranty 2
wireless 5, 14, 15, 35, 44, 110
Settings. See Preferences
ShortCuts
Favorites 37, 49-51
menu commands 21, 129
MMS, templates 69
SMS, QuickText 64
Signal strength 35, 134
Signature 80
SIM card
ALS 148
defined 13, 149
Email center number 68
importing contacts from 36, 48
inserting and removing 13, 16,
134,136
locking and unlocking 121,
122-123, 149
Message Center number 68
PIN 149
preferences 68
PUK 149
slot 9, 11, 13
tray 13
Slider 19, 114
Small font for text 115
SMS
alerts 111
chat threads 67
creating messages 51, 64
defined 149
deleting messages 66, 67
dialing from 38
editing draft messages 66
Inbox 66

opening 25-26, 64
Preferences 67-68
purging messages 66
QuickText 64
receiving messages 65, 120
saving draft messages 66
sorting messages 66
SMS Messages. See SMS
Soft reset 131, 133, 134, 138,
145, 146
Sorting
applications 116
browser bookmarks 56
browser history 58
by date 68, 66, 71, 77, 89
Favorites 51
messages 66, 71, 77
pictures 62
To Do items 88, 89
Sounds 14, 15, 39, 50, 63, 65,
69, 70,71, 77,106, 110-111,
113,120
Speaker 11,52, 113
Speakerphone 12, 42, 67, 111
Speed Dial. See Favorites
Standing Meetings. See Repeating
events
Starting applications. See
Launching
Stylus
accessing reset tool 11, 131,
132
dragging with 19, 20, 55, 56
locating 9
tapping with 18-21
Switching calls 43, 52
Symbols 23-24, 148
Synchronizing data. See HotSync
System requirements for Desktop
software 27

T
Technical Support 32
Templates
MMS 69
QuickText 64
Text
copying 57

entering. See Entering data
finding 22, 36, 50, 58, 77,
956-96, 125, 129
fonts for 1156
pasting 37, 57
selecting 19-20
Third-party applications 18, 73, 77,
96, 100-103, 126, 128, 129,
130, 131, 132, 138, 139, 140,
141, 145, 146, 147, 149
Time
alarm setting 83
Auto Lock 123
automatic email delivery 79,
140
bars in Calendar 85
battery life 31
Daylight Savings 118
format 119
Home City 91
remote cities 92
setting current 118
setting event 82, 83
stamps 68
start and end for Calendar Day
view 84
Tips
Information icon 32, 142
printed 5
online 32, 141
To Do List 86-89, 115, 120
Today. See Current date and time
Touchscreen
calibrating15, 115, 133
caring for 10,
disabling during calls 39, 42,
121,122,134
see also Display
Transferring data. See HotSync
Transmitting data. See Beaming
Turning on and off
automatically 121, 122, 135
displaying owner's name 124
keyboard backlight 22, 129
phone 14, 135
problems with 12, 31
screen 14
Wireless Mode 14, 15, 135
Typing. See Entering data

U

Uninstalling Desktop software
138, 139
Unlock code 122-123
Unresponsive phone 131, 145
Untimed events 82, 83
Updating data. See HotSync
Upgrading 63, 103, 128, =129,
138
USB cable 9, 27-28, 138
User name
data services 136
desktop software 101, 102,
128, 137,139, 149
email 142
HotSync 101, 102, 128, 137,
139, 149
phone 101, 102, 128, 137,
139, 149

\Y

Vibrate 39, 65, 113

Voicemail 40-41, 51

Volume 10, 16, 39, 94, 110-111,
118,120

W
Warm reset 131, 132, 145
Web pages. See Blazer
Windows. See Microsoft
Wireless mode 19
indicator 10
turning on and off 14, 15, 135
troubleshooting 134-136
See also Network




Specifications

Radio

GSM 850/900/1800/1900 quad band world phone

GPRS class 10, class B; also supports CSD

Phone features

Personal speakerphone
Hands-free headset jack
(2.5 mm, 3-barrel connector)

* Microphone mute option
« TTY compatible
+ 6-way calling

Processor technology

Texas Instruments OMAP 1510 (ARM) processor

Expansion

SD/MMC slot (SD 1/0 compatible)

Battery

Rechargeable Lithium lon
3 hours full charge time

« 5 hours talk time, 10 days standby

Palm OS version

Palm OS 5.2.x

Camera

VGA resolution (640x480), 0.3 megapixel

« Automatic light balance

Size

441 inx 236 in x .87 in (11.2 cm x 6.0 cm x 2.2 cm) with antenna

Weight

5.92 ounces (1676 grams)

IR

Yes

Display

LCD Touchscreen (includes stylus)
3375 colors (11.5-bit color, compatible
with 16-bit applications)

* User-adjustable brightness and contrast

Keyboard

Built-in QWERTY keyboard plus 5-way navigation control

Backlight for low lighting conditions

Included software

Phone (including Palm OS Contacts,
Favorites, Dial Pad)

Camera

MMS

Blazer Web Browser (Internet)

Memo Pad

PocketMirror Standard (for synchronizing
with Microsoft Outlook for Windows)

Calendar (Palm OS Date Book+)
SMS

Mail

To Do List

Calculator (basic and advanced)
Palm Desktop and HotSync Manager
CityTime world clock

System requirements

Windows 98SE, Me, 2000 or XP with
USB port. Windows NT4 requires serial
cable, sold separately

Mac 0S 10.1-10.2.x with USB port
Later versions may also be supported

Operating and storage
temperature range

0C-40C

5% to 90% RH




